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Introduction 
With sudden increase in the usage of computer and software globally, schools are focusing on 

computer education with the BEST (BEYOND IMAGINATION, EXCELLENT, 

SYSTEMATIC, TEACHING PLAN) learning technique. But the study material used was not 

fulfilling the requirement of modern BEST based training, followed with traditional 

educational methodology with outdated software versions. 

Computer Applications for Class IX is the latest and advanced computer book which has 

been prepared, keeping in mind the interest of students and teachers in the field of 

Information Technology. In compliance with the prescribed curriculum, this book covers 

basics of information technology, cyber safety, Office productivity tools and programming 

basics with Scratch and Python.  

The book is designed  with an interactive and hands-on approach to communicate the 

essential aspects of computer. We have used simple language in the entire series for precise 

and better understanding. 

 

Class IX 
 

UNIT 1 
 

Chapter (1) - Computer System 

 

A. Choose the correct answer. 

1. (b) Feelings 2. (d) All of these 3. (a) Two 4. (c) Input Unit  

5. (a) Primary Memory 6. (d) None of these 7. (b) CU 

B. Short answer type questions. 

1. Some of the limitations of computer are: 

• Zero IQ: Computer has lack of decision-making ability. Computer cannot take 

decisions itself. Computers need to tell each and every step. They are dumb machine 

with zero IQ.  

• Computer does not learn anything from its past experience.  

• No Feeling: Computer does not have feelings, emotion, taste, knowledge or 

experience. 

2. A computer is basically made up of two parts: hardware and software. 

 Hardware: These are the physical parts of computer. For example, monitor, keyboard, 

mouse etc. 
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 Software:  These are the set of (computer) programs. These are used to do work on the 

computer. 

3. Three parts of CPU are: Arithmetic and Logic Unit, Control Unit and Registers (Memory 

Unit). 

4. It is a type of memory which is primarily used by CPU for booting of system and 

temporarily storage of data for processing. For example, RAM. 

5. ROM helps the computer to start up. It contains a set of start-up instructions called, 

“bootstarp loaders”. These instructions help the computer to start up or boot itself, when 

we switch it ON.  

6. Differences between RAM vs ROM are: 

RAM ROM 

i. It is volatile memory. i. It is non- volatile memory. 

ii. It is primarily used by CPU for 

temporarily storage of data for processing. 

ii. It is used by CPU for booting of  

system. 

iii. Some types of RAM are SRAM, DRAM, 

etc. 

iii. Some types of ROM are EPROM, 

EEPROM, etc. 

 

7. Computers are being used to develop computer-based training packages, for e-learning 

and online education (using Internet). Now, students are exposed to the internet and it 

helps them to improve and update their knowledge. 

8. Computers are used for research and experiment purposes. Weather forecasting, 

automobile designing, nuclear weapon designing and testing, space research, aircraft 

simulation designing and much more scientific research areas are there, where computers 

(super and mainframe computers) are being used.  

Computer Aided Designing (CAD) and Computer Aided Engineering (CAE) are few 

tools used in to assist in the creation, modification, optimization of a 2D and 3D design 

and to analyze the robustness and performance of components and assemblies/ products.    

9. Computers are proving a very big means of communication. Along with e-mail service, 

text, voice and video chatting are very popular way of communication now-a-days. 

10. Computers are used to handle the accounts of customers. These days, all the nationalized 

banks are computerized and centralized. We can see ATMs around us to withdraw cash 

from our bank account without going to bank. E-banking or internet banking and mobile 

banking are widely used widely by masses, and have numerous benefits to offer.  

11. Using computer we can play games (on Internet also), listen to music and watch music. 

Computer also helps to create cartoon movies (2D and 3D). Use a computer we can 

generate special effects on a movie. 

12. Computer plays the major role to develop crucial military weapons. Whether it is missile 

system, tanks, sun-marines, War ships etc. computers are used (with special hardware and 

softwares). 

13. Computers are used by police to monitor speeding vehicles as well as to monitor people 

violating law. Advance computer techniques like DNA and finger print matching 

techniques can be used to identify the criminals. 
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C. Long answer type questions. 

1. DRAM: As the name suggests, this memory gets refreshed periodically. This form of 

memory is less expensive and slower than static RAM. 

 SRAM: This form of RAM is more expensive than dynamic RAM, but is generally faster 

and requires less power than DRAM and, in modern computers, is often used as cache 

memory for the CPU. 

 DDR RAM: DDR RAM is based on SDRAM architecture, but it utilizes the clock signal 

differently to transfer twice the data in the same amount of time. It achieves greater 

bandwidth than the preceding single-data-rate SDRAM by transferring data on the rising 

and falling edges of the clock signal (double pumped). 

2. PROM: Once the information or data is recorded on this memory, it cannot be changed or 

erased.  

 EPROM: The information or data stored in it can be erased by exposing it to ultra violet 

light. 

 EEPROM: It is user modifiable read-only memory that can be erased and reprogrammed 

repeatedly using electrical charge. 

3. Cache is a type of RAM i.e., SRAM. Cache memory is fast memory that is built into 

computer’s CPU or located next to it on a separate chip.  

The CPU uses cache memory to store instructions that arerepeatedly required to run 

programs, which improves overall system speed (because CPU does not have to use the 

motherboard’s system bus for data transfer). When the required data is not available in 

cache memory than CPU access the required data from RAM or other storage, the data 

transfer speed slows due to Disc reading and the motherboard’s system bus capability. 

 

A. Fill in the blanks. 

1. Arithmetic, logical 2. Second 3. Physical, hardware  4. Software 

5. IPO process 6. ALU, CU, Memory Unit (Registers) 7. Zero  8. Memory 

9. SRAM 

B. State true or false. 

1. True 2. False 3. True  4. False 5. True  6. False  

7. False 

 

 

Chapter (2) – Components of Computer 

 

A. Choose the correct answer. 

1. (c) Navigation keys 2. (b) Wireless Mouse  3. (d) All of these 4. (b) OCR 

5. (d) MICR   6. (a) Light Pen  7. (c) Barcodes, barcode reader 

8. (a) Digital Camera 9. (c) LED Monitor  10. (c) Laser Printer  
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11. (a) Dot Matrix printer 12. (c) Plotter   13. (d) RAM 

14. (d) Cache   15. (a) Blu-ray Disc  16. (c) Bit  

B. Short answer type questions. 

1. (a) Difference between mechanical mouse and optical mouse. 

Mechanical Mouse Optical Mouse 

(i) It has a rubber or metal ball on its 

underside. 

(i) It has a LED (laser) on its underside. 

(ii) A sensor within the mouse detects the 

motion of ball and moves the pointer. 

(ii) It detects the movement of mouse 

relative to the surface by sensing changes in 

the reflected light.    

 

 (b) Difference between hand-held scanner and flat-bed scanner. 

 Hand-held scanner Flatbed scanner 

(i) It is a handy device useful for portability. (i) It is made up of flat glass surface. 

(ii) It is generally used for capturing the text. (ii) It is used to scan documents and photos 

of good quality.   

  

(c) Difference between OCR and MICR. 

OCR MICR 

(i) It is us dot read alphabets and numeric 

characters on a document. 

(i) It is used to magnetic ink characters 

primarily for the processing of bank cheque. 

(ii) It uses light source to read characters and 

then convert images of text into characters. 

(ii) The MICR read head is a device built 

into the scanner designed to read the 

magnetic signal emitted by the MICR ink 

characters on the cheque.  

 

(d) Difference between CRT monitor and LCD monitor. 

CRT monitor LCD monitor 

(i) It is similar to television. (i) It is thin, flat display device. 

(ii) It works on the Cathode Ray Tube 

technology. 

(ii) It uses Liquid Crystal Display 

technology.  

 

(e) Difference between inkjet printer and laser printer. 

Inkjet printer Laser printer 

(i) It prints by spraying ionized ink on a 

sheet of paper. 

(i) It prints the characters by laser beam. 

(ii) Print speed is slower than laser printer. (ii) Print speed is faster than inkjet printer. 
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(f) Difference between mouse and light pen. 

Mouse Light Pen 

(i) It is a pointing device that rolls on flat 

surface. 

(i) It is a pen shaped pointing device that 

point the displayed object or draw on the 

screen. 

(ii) It has two or three buttons on the top and 

a scroll wheel. 

(ii) It consists of a photo sensor at the tip. 

 

(g) Difference between scanner and digital camera. 

Scanner Digital Camera 

(i) It converts a document, graphic etc. to a 

digital image. 

(i) It records and store photographic images 

in digital form. 

(ii) It is used to scan documents and images. (ii) It is used to take photographs. 

 

(h) Difference between CD-ROM and DVD. 

CD-ROM DVD 

(i) It can store up to 700 MB data. (i) It can store up to 17 GB data (depending 

on its’ type). 

(ii) CD-ROM can be single - sided and 

single- layered only. 

(ii) It can be single- or double-sided, and can 

have two layers on each side. 

 

1. Five examples of input devices are keyboard, mouse, scanner, OCR and MICR. 

2. Joysticks are often used to control video games. Joysticks are also used in civilian and 

military aircraft, cranes, underwater unmanned vehicles, wheelchairs, surveillance 

cameras and zero turning radius lawn movers. 

3. Microphones are used in many applications such as telephones, tape recorders, hearing 

aids, motion picture production, live recording and audio engineering, in radio and 

television broadcasting and in computers for recording voice. 

5. Four example of output devices are monitor, printer, speakers and plotter. 

6. A Pen drive is a USB flash memory. It is a portable storage media. It can store up to 1 TB 

data. (Kingston’s DataTraveler HyperX Predator 3.0 can store up to 1TB).  

7. A memory stick is a removable flash memory card format, digital data storage device 

which is used in digital cameras, digital music players and camcorders. 

C. Long answer type questions. 

1. (a) Difference between Hard Disk and Pen Drive. 

Hard Disk (internal) Pen Drive 

(i) It is non- portable device. (i) It is portable memory. 

(ii) It is generally used to store data in (ii) It is used to transfer data form one 
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computer permanently. computer to another. 

(iii) It is used to store large amount of data. (iii) It is generally used to store small amount 

of data. 

(iv) It is expensive. (iv) It is cheaper than hard disk. 

 

(b) Difference between Impact Printer and Non-Impact Printer. 

Impact Printer Non-Impact Printer 

(i) It produces text and images when tiny 

wire pins on print head strike the ink ribbon 

by physically contacting the paper. 

(i) It produces text and graphics on paper 

without actually striking the paper. 

(ii) Printing speed is slow. (ii) Printing speed is high. 

(iii) Printing quality is very low. (iii) High quality of output, capable of 

printing fine and smooth details. 

(iv) For example, Dot Matrix printer. (iv) For example, Laser printer. 

 

(c) Difference between Dot Matrix Printer and Laser Printer. 

Dot Matrix Printer Laser Printer 

(i) It has low printing cost. (i) The printing cost is high than the dot 

matrix. 

(ii) It’s printing speed is slow. (ii) It’s printing speed is high. 

(iii) It produces a lot of noise while printing. (iii) It is almost silent. 

(iv) It prints one character at a time. (iv) It prints entire line a time. 

 

(e) Difference between Printer and Plotter. 

Printer Plotter 

(i) All printers are definitely not plotters. (i) All plotters can be considered printers. 

(ii) Printers are used to draw images through 

dots. 

(ii) Plotters are used to draw line images. 

(iii) Printers make use of laser technology. (iii) A plotter holds pen and draw lines. 

(iv) Printers cannot make use of large papers. (iv) A plotter can draw very large images 

that are of use in architecture. 
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2. Types of keys on a computer keyboard are: 

• Typing (alphanumeric) keys- These keys include the alphabet, number, punctuation, 

and symbol keys.  

• Control keys- These are Ctrl, Alt, the Windows logo key and Esc. These keys are used 

alone or in combination with other keys to perform certain actions.  

• Function keys- The function keys are used to perform specific tasks. They are labeled 

as F1, F2, F3 … to F12.  

• Navigation keys- They include the arrow keys, Home, End, Page Up, Page Down, 

Delete, and Insert. These keys are used for moving around in documents or web pages 

and editing text.  

• Numeric keypad- On numeric keypad, keys are grouped together in a block like a 

conventional calculator for entering the numbers quickly. 

3. Blu-ray, also known as Blu-ray Disc (BD) is the name of a new optical disc format that is 

rapidly replacing DVD. The format was developed to enable recording, rewriting and 

playback of high-definition video (HD), as well as storing large amounts of data. The 

format offers more than five times the storage capacity of traditional DVDs and can hold 

up to 25GB on a single-layer disc and 50GB on a dual-layer disc.  

4. Units of Computer Memory Measurements: 

 1 Bit = Binary Digit 

 8 Bits = 1 Byte 

 1024 Bytes = 1KB (Kilo Byte) 

 1024 KBs = 1MB (Mega Byte) 

 1024 MBs = 1GB (Giga Byte) 

 1024 GBs = 1TB (Terra Byte) 

 1024 TBs = 1PB (Peta Byte) 

 1024 PBs = 1EB (Exa Byte) 

 1024 EBs = 1ZB (Zetta Byte) 

 1024 ZBs = 1YB (Yotta Byte) 

 1024 YBs = 1(Bronto Byte) 

 1024 Brontobytes = 1(Geop Byte) 

 Geop Byte is The Highest Memory Measurement Unit 

 

A. Fill in the blanks. 

1. Keyboard  2. Mouse 3.Sound 4. Light Pen  5. Booting  

6. Hard Disk  7. Flash Memory 8. DVD 9. ZB (Zetta Byte) 

B. State true or false. 

1. True 2. False 3.True  4.True  5. False 6. False  

7. False 8. True  9. False 
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Chapter (3) – Computer Software 

 

A. Choose the correct answer. 

1. (a) Program 2. (a) System  3. (d) None of these  4. (b) GUI  

5. (c) None of these 6. (c) Maya 7. (d) MS-Excel 8. (d) Database Management  

9.  (d) All of these 10. (d) Virus Cleaner 

B. Short answer type questions. 

1. Software is a set of programs which is designed to control the operations of a computer 

system and make the hardware run on a computer system. There are two types of software 

– System Software and Application Software. 

2. GUI stands for Graphical User Interface. A program interface that takes advantage of the 

computer's graphics capabilities to make the program easier to use. A GUI operating 

system is a user friendly interface and a normal user can easily operate the system. In 

GUI interface a user can perform the task with icons, folders. For example, Windows, 

Linux and Mac. 

3. The functions of operating system are – Memory Management, Booting the computer, 

Perform Basic Computer task, Handling and sharing of resources (Hardware & Software). 

4. An application software is set of program, designed to perform some specific type of task. 

This software is specially designed according to a user requirement to perform a 

particular type of task. For example, Word Processor, Presentation Software, Railway 

Reservation, Tally, etc. 

5. A database is a collection of large amount of interrelated information. It is an application 

software specially which is designed to store large amount of information in the form of a 

table.  

6. Disk Defragmenter tool is a utility in an operating system which is designed to increase 

access speed by rearranging files stored on a disk to occupy contiguous storage locations, 

a technique called defragmentation. Defragmenting a disk minimizes head travel, which 

reduces the time it takes to read files from and write files to the disk. 

7. The raw materials, work-in-process goods and completely finished goods that are 

considered to be the portion of a business's assets those are ready or will be ready for sale. 

8. The translation of data into a secret code is called encryption. Encryption is the most 

effective way to achieve data security. To read an encrypted file, you must have access to 

a secret key or password. 

C. Long answer type questions. 

1. An operating system is system software which is designed to control the internal 

operations of a computer system. It controls the hardware and software resources of a 

computer interface. It acts as a bridge between a user and a computer. Without operating 

system a computer is a dumb machine of metal. On the basis of interface an Operating 

System can be categorized in two interfaces – CUI and GUI. For example UNIX & DOS 

is the example of CUI interface while Windows (XP, Vista, 7, 8) is the example of GUI 

interface. 

2. Difference between general purpose software and specific purpose software: 
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 General purpose software Specific purpose software 

(i) It is a type of software that can be used 

for a variety of tasks. 

(i) It is a type of software created to execute 

one specific task. 

(ii) It is sometimes known as ‘off-the-shelf’ 

is the sort of software that you use at home 

and school. 

(ii) It is more limited and performs the 

specific needs of a particular profession or 

business. 

(iii) These softwares are easily available in 

the market and relatively cheap. 

(iii) These softwares are available in the 

market at selected vendors and relatively 

costlier than general purpose software. 

(iv) Examples include word processors, 

spreadsheets, databases, desktop publishing 

packages, graphics packages, etc. 

(iv) For example, TurboTax (a tax 

preparation package). 

 

3. Types of general purpose software are: 

Word Processing Tool - This type of software allows a user to enter the text, modify the 

text and format the text. In this tool, a user can design a text document along with some 

basic graphics. 

Presentation Software - This software is used to design a multimedia presentation for 

the better communication. 

Spreadsheet Software - This is an electronic sheet made up of rows and columns to store 

the data in tabular form. It is used to perform calculation, result analysis, keeping the 

records etc. 

4. Types of special purpose software are:  

Reservation Software - This software is used by railways and airlines to book the seats. 

Attendance Software - This software is used to record and track the attendance of the 

employees in a company. It helps the payroll department to calculate the salary of an 

employee. 

Hospital Management System - This software keep the records of all patients who visit 

or admit in the hospital. It also used to calculate the total bill of a patient according to the 

utilization of services. 

5. Utility software is a computer software designed to help in the management and tuning of 

operating systems, computer hardware and application software. It is designed to perform 

a single task or a multiple of small tasks. Examples of utility software's include Disk 

defragmenters, Compressor, Application Launchers, Backup Software and Anti-Virus.  

Data Backup – Generally backup means making a copy of the data (stored in hard disc 

in the computer). The backup utility software takes a backup of complete data and stores 

it in some storage device. In future if the data gets lost this utility software also helps to 

recover the data back. 

Anti-Virus – Antivirus software perform a very vital role to keep the computer safe from 

virus and other attacks. It cleans up all the virus and unwanted threats from the computer 

by scanning. 
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A. Fill in the blanks. 

1. Commands and Instructions 2.  Commands  3. Word Processor  

4. Database 5. Reservation  6. Anti-Virus 7.  School Inventory Control 

B. State true or false. 

1. True 2. True  3. False 4. False 5. True  6. True   

7. False 8. True 

 

 

Chapter (4) – Operating System (MS Windows) 

 

A. Choose the correct answer. 

1. (c) Programs 2. (d) All of these  3. (d) Network Management 

4. (d) None of these 5. (d) Windows Manager 6.  (a) Primary and Secondary name 

7. (b) Ctrl + Shift + N 8. (d) F2 9. (a) Select the file and press Delete key 

10. (b) Recycle Bin 11. (a) Pointer  12. (d) None of these 

B. Short answer type questions. 

1. The Start menu is the main gateway to your computer's programs, folders, and settings. It 

is called a menu because it provides a list of choices, just as a restaurant menu does. 

2. Using Start Menu:  

Click on Start button → Go to All Programs → Select the required application to open.  

Using Run/Search option: 

Click on Start button → Click on Run/Search → Type the file’s name → Click on Ok 

button to open the application. 

3. Primary name of the file is user defined that is provided by the user. The Secondary name 

of the file is the extension of the particular program in which the file is designed. 

4. Open Computer window → open ‘D:’ drive → Right click on the blank area →Select the 

New option →choose Folder option. A new folder will be created.  

5. Open Computer window → open ‘E:’ drive → Select the required file → Right click on 

the file → Select the Rename option. Name of the file is selected with a cursor blinking 

on starting of the name. Type the new name and press Enter key.  

6. Select the file from the desktop → Right click on the file → Select the Delete option → 

Press the Yes button to delete the file. 

7. Open My Document window → Select the file that you need to move → Right click on 

the file → Choose the Cut option → Open the D: drive in My Computer window → Right 

click from the mouse on blank space → Choose the Paste option. 

8. Open the E: drive in Computer window → Select the required Folder (of which you need 

to create a shortcut) → Right- click on the selected folder and select ‘Send to’ option. → 

Select ‘Desktop (create shortcut)’ option. 
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9. Right click on the Desktop → Select the Personalize option → Select the required 

wallpaper from the available themes. 

10. To arrange icons by name, type, date, or size, right-click on blank area on the desktop. → 

click Sort option → Click the required option (e.g. Name, Size, Item type and Date 

modified). 

11. Microsoft Windows is an operating system. It contains the instructions for your computer 

to open, manage and store its directories and files. A Window is the part of MS-Windows 

that can be called an application window or main window. It typically has a frame with a 

title bar, Minimize and Maximize buttons, and other standard UI elements. 

12. Windows operating system has some inbuilt application and utility tools that are known 

as accessories. It contains some important applications such as Notepad, CMD, 

calculator, WordPad, System Tools, etc. 

C. Long answer type questions. 

1. Below given are mouse (click) functions: 

Clicking (left clicking) – Left- click of the mouse is used to select and click items, 

position the cursor in a document, and drag items.  

Right- clicking – Right- click of the mouse is used to display the context menu of tasks 

or options that changes depending on where you click. 

Dragging - Dragging (sometimes called dragging and dropping) is most often used to 

move files and folders to a different location and to move windows and icons around on 

the screen. 

2. Icons - Icons are the small graphical symbol of a program on the desktop. It give you the 

quick access shortcut of the installed application in the computer system. You can show 

them all or hide them all, if you prefer a clean desktop. You can also resize them. 

 Wallpaper - Wallpaper is an image used as a background of a graphical user interface on 

a computer screen or mobile communications device. On a computer it is usually for the 

desktop, while for a mobile phone it is usually the background for the 'home' or 'idle' 

screen. Though most devices come with a default picture, users can usually change it to 

files of their choosing. 

 Gadgets - These are the small and helpful technical objects. They have their specific 

function. It is very useful for giving technical help to users like watching time, calendar, 

weather, puzzle games, and many more. 

 Taskbar - This is a bar that is usually found at the bottom of the screen. It has the start 

button, the clock and some toolbar and the buttons corresponding to all open windows. 

3. The steps to change system date and Time are: 

i. Click on time and date on the Taskbar. 

ii. Click on ‘Change date and time settings’ link, the Date and Time dialog box appears. 

iii. On Date and Time tab, click on ‘Change date and time…’ button, the Date and Time 

 Settings dialog box appears. 

iv. Set the date and time in the given controls and click OK button, the current dialog box 

disappears. 

iv. Click on OK button on Date and Time dialog box.  
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4. Computer window provides access to the files and folders that are stored in the memory. 

We can view, delete, copy or move files and folders using this window. 

 Several parts of Computer window are,  

i. Address bar- It displays the address of the selected drive or folder. 

ii. The Search box- It helps to search about files and folders in the computer. 

iii. Navigation pane- Using navigate pane, we can navigate through all the memory 

drives. 

iv. Toolbar- It provides the tools related to the selected drive and folder to work with 

them. 

v. Details pane- It gives the details of the selected drive, folder and file like- drive size, 

total number of items, date of creation, date of modified, etc. 

5. Steps to copy a folder from the Desktop to D: drive are, 

i. Select the folder from the Desktop and right click on it.  

ii. Choose the Copy option from the shortcut menu. 

iii. Open the D: drive of the computer using Computer window. 

iv. Right click on the empty area in the drive and choose the Paste option from the 

shortcut menu. 

6. Various parts of a window are – 

Title Bar - The title bar tells you the name of the application. There is an exception 

however; Windows Explorer will not show its name in the title bar. The tile bar also 

contains 3 sizing buttons, at the top right corner. 

Maximize Button - Click on this button to enlarge the window to fill the entire desktop. 

Minimize Button - This button is used to reduce the size of the window to a button on 

the taskbar. Minimizing a window does not close it; it simply hides it from you. 

Resize Button - This button is used to restore the window to its original size i.e., to the 

size before you maximized it. 

Close Button – This button is used to close active window. 

Menu Bar - Below the title bar is Menu Bar. This displays the various menus available to 

you. When you click on a menu option, says File, all the sub-options appear as a drop 

down menu. You can select any one of them by pointing to it with the mouse pointer and 

then clicking it. 

Horizontal Scroll Bar – This is used to move the page from left side to right side. 

Vertical Scroll Bar - This is used to move the page from top to bottom. 

Workspace – Workspace is the area of a window where a user can perform the task by 

entering the text. 

7. Steps to apply the screen save are – 

i. Right click on empty area on the Desktop and select Personalize option. 

ii. A window appears to ‘change the visuals and sound on your computer’.   
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iii. On the right-bottom corner, click on Screen Saver icon/link, the Screen Saver Settings 

dialog box appears. 

iv. Select the required pre-installed screen saver from the list in Screen Saver section.  

vi. Set the timings for the screen saver using Wait text box.  

vii. You can see the preview of the screen suing Preview button. 

viii. Click on Apply button. Click on OK button. 

 

A. Fill in the blanks. 

1. Operating system  2. Booting  3. Icons 4. Wallpaper   

5. Start button  6. A window 

B. State true or false. 

1. False 2. True  3. True  4. False 5. False 6. False 

 

 

Chapter (5) – Computer Networking  

 

A. Choose the correct answer. 

1. (a) Computer 2. (d) All of these 3. (c) WAN 4. (c) Monitor   

5. (c) Both (a) and (b) 6. (c) Optical fiber cable 7. (d) Straight Ethernet cable 

  

8.   (c) Wi-Fi  9. (d) ARPANET 10. (a) Modem  11. (b) Infrared  

12. (c) Data  13. (a) Multimedia 

B. Short answer type questions. 

1. Modem is a device that is used to connect a computer on internet with the help of a 

telephone line. 

2. Communication media is a way through which a communication channel can be 

established between devices to communicate and sharing the data. 

3. An Ethernet cable is one of the most popular forms of network cable used on wired 

networks. Ethernet cables connect devices on local area networks such as PCs, routers 

and switches. 

4. Bluetooth is a wireless technology standard for exchanging data over short distances from 

fixed and mobile devices and building personal area networks (PANs). 

5. IR wireless is a wireless technology in the devices or systems that convey data through 

infrared (IR) radiation. 

Disadvantages:  

i. Infrared communication span very short distances. 
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ii. Infrared signals cannot penetrate (come through) walls or other obstructions and work 

only in the direct ‘line of sight’. 

6. Interspace is a client/server software program that allows multiple users to communicate 

online with real-time audio, video and text chat in dynamic 3D environments. Inter space 

provides the most advanced form of communication available on the Internet today. 

C. Long answer type questions. 

1. Advantages of computer networks are :  

i. Share printers and other peripherals to cut down the cost of individual equipment for 

each machine  

ii. Backups across the network of all machines with a click of a button or automatic to 

ensure all the data are stored in case of fire or theft.  

iii. Internet, Point Of Sale programs and accounting programs can be shared across 

multiple computers for multi-user access 

4. Sensitive files and programs on a network are password protected so that all the 

information must be secured on the network. 

iv. The main advantage of a computer network is that it allows a user to file sharing and 

remote file access from one computer to another computer. 

2. LAN - Local Area Networking is used primarily in small areas such as schools, hospitals 

and office buildings. Local Area Networking is one of the older types of networks. 

TCP/IP is used as the method of communication between computers in Local Area 

Networking. 

MAN - Metropolitan Area Networks are not commonly used these days, they are used to 

create communication between systems in an entire city. Hence a Metropolitan Area 

Network area falls between the sizes Local Area Networks, and Wide Area Networks. 

WAN - Wide Area Networks are used to connect server machines and computers across 

countries for sharing the information and updates. Wide Area Networks, are used across 

the globe, many networks connect with one another across countries to create one giant 

Wide Area Network. Internet is the example of WAN. 

3. Modem: Modem is a device that enables a computer to transfer the data through telephone 

cables. The modem changes these digital signals to analog signals that can be transmitted 

through the telephone cables. 

Network Interface Card (NIC)/ LAN card: A Network Interface Card (NIC) is a computer 

hardware device designed to allow computers to communicate over a network.  

Repeater: A repeater is a network device. It receives a signal and regenerates it. It then 

transmits the signal at a higher level or higher power onto the other side. So, the signal 

can cover longer distance without any change. 

Hub: A hub is a component that duplicates the information and makes the data available 

to all systems. A hub has multiple ports. When a data packet arrives at one port, it is 

copied to other systems. 

Bridge: A bridge is a device used to connect two local area networks (LANs) or two 

segments of the same LAN that use the same protocol. It forwards data depending on the 

destination address in the data packet.  
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Switch: A switch is a device used to transmit the data received from several input ports to 

the specified output port, which in turn sends data to the receiver's system. It identifies the 

output ports' addresses by using the MAC address in a LAN and by using the IP address 

in a WAN. 

Router: A router is a device used to forward the data packets. It finds a specified path to 

send data through networks. It can be used to connect a LAN to a LAN, a WAN to a 

WAN, or a LAN to the Internet. 

4. a) The differences between wired and wireless network are –  

WIRED NETWORK WIRELESS NETWORK 

i) If you can see the network cable going 

to a location, that location can be 

connected to the network. 

i) Wireless networks sometimes connect 

locations that you cannot visibly see. 

Additionally, wireless networks might 

not connect locations that you cansee 

visibly. 

ii) All of the nodes on a wired network 

can hear all other nodes. 

ii) Many nodes on a wireless network 

cannot hear all of the other wireless nodes 

on the same network. 

iii) The presence of one wired network 

has no effect on the performance of 

another wired network. 

iii) One wireless network can affect the 

performance of other wireless networks. 

iv) Wired network performance is not 

affected by the atmosphere. 

iv) Wireless network performance can be 

affected by the atmosphere. 

 

b) The differences between Co-axial cable and Ethernet cable are 

Co-axial cable Ethernet cable 

i) It is generally used by cable TV 

companies to transmit TV signals from 

antenna to TV sets. 

i) It is generally used to connect 

computer system, switches and modems. 

ii) It consists of a center wire surrounded 

by insulation and then a grounded shield 

of braided wire. 

ii) It consists of 4 pairs of cross cables 

(with different colours).   

iii) Data is transmitted through the center 

wire, while the outer braided layer serves 

as a line to ground. 

iii) It can be used in two types: cross 

cable and straight cable. 

iv) The ‘F connector’ (coaxial RF 

connector) is used to connect coaxial 

cable with data receiving device. 

iv) It has an eight pin jack at the end to 

plug into network. 

 

c) The differences between Bluetooth and Wi Fi are 

BLUETOOH Wi Fi 

i) Bluetooth technology is built into 

electronic gadgets and allows them to 

i) Wi-Fi is often referred to as "wireless 

internet", because that's what it is most 
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connect directly with each other 

wirelessly. 

often used for, accessing the internet. 

ii) It is used to connect the devices on a 

PAN network 

ii) Wifi is used to connect the devices on 

a LAN network 

iii) Bluetooth allows devices to share the 

files such as music, photos and allow 

speaking with wireless headset. 

iii) Wi-Fi allows the devices to connect 

over the internet. 

iv) Bluetooth provides a short range to 

connect the devices. (30 feet). 

iv) Wi-Fi single can be picked up to 300 

feet to connect devices. 

 

d) The difference between data and information are 

DATA INFORMATION 

i) Data is known as raw facts and 

material. 

i) Information that is complete in itself, 

ii) It is unprocessed information. ii) It is a processed data. 

iii) It provides incomplete information. iii) It is the final output after processing 

data. 

iv) By using the data a user cannot take 

the necessary decisions. 

iv) Information helps a user to take 

necessary decisions. 

 

5. Optical fiber technology uses glass (or plastic) threads (fibers) to transmit data. A fiber 

optic cable consists of a bundle of glass threads, each of which is capable of transmitting 

messages modulated onto light waves. 

Fiber optics has several advantages over traditional metal communications lines: 

• Fiber optic cables have a much greater bandwidth than metal cables. This means that 

they can carry more data. 

• Fiber optic cables are less susceptible than metal cables to interference. 

• Fiber optic cables are much thinner and lighter than metal wires. 

• Data can be transmitted digitally (the natural form for computer data) rather than 

analogically. 

Its advantages are: 

• It is expensive than other wired media. 

• It has higher installation cost. 

6. We can use Internet in different ways. Some of the uses of Internet are given below: 

 i. E-mail and Chatting- You can send and receive instant messages (e-mails) using 

internet. Various things such as pictures, videos, songs, e-cards can be added along with 

email messages. Your messages are delivered instantly to people anywhere in the world, 

unlike traditional mail that takes a lot of time. E-mail is now an essential communication 

tools in business. It is also excellent way of keeping in touch with family and friends. The 

advantages to email is that it is free (no charge per use) when compared to telephone, fax 



  Computer Applications CBSE Code 165 

 

18 

 

and postal services. We can chat with our friends using ‘chat room’ and stay in touch with 

the friends. 

 ii. News and Information- The internet provides facility to read different newspapers 

online and get the information regarding various topics of our interest such as science, 

technology, sports, education, etc. It also keeps us updated on current events. The Internet 

is a virtual treasure trove of information. Any kind of information on any topic under the 

sun is available on the Internet. The ‘search engines' on the Internet can help you to find 

data on any subject that you need. 

 iii. Services- Many services are now provided on the internet such as online banking, bill 

payments, job seeking and applications, and hotel reservations, railway and air tickets 

booking etc. Often these services are not available off-line or cost more. 

iv. Online Shopping- The internet is a very effective way to buy and sell products all 

over the world. Along with getting information on the Internet, you can also shop online. 

There are many online stores and sites that can be used to look for products as well as buy 

them using your credit card. You do not need to leave your house and can do all your 

shopping from the convenience of your home. 

 v. Communities- Communities of all types have sprung up on the internet. It's a great 

way to meet up with people of similar interest and discuss common issues. 

 vi. Software Downloading- You can download free games, videos, software, 

educational information and music from internet. 

7. Multimedia means media or medium of communication that uses multiple forms of media 

such as text, audio, images, video, animation and interactivity. Multimedia softwares are 

computer applications which can process information. The information can be processed 

in a number of media formats. The addition of animated images (for example, animated 

GIF on the Web) produces multimedia, but it has typically meant one of the following: 

• Text and sound 

• Text, sound, and still or animated graphic images 

• Text, sound, and video images 

• Video and sound 

• Multiple display areas, images, or presentations presented concurrently 

D. Match the following –  

COL-I  COL-II 

1. - d.   

2. - c.   

3. - e. 

4. - f. 

5. - b. 

6. - a.  
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A. Fill in the blanks. 

1. LAN 2. WAN 3. Modem 4. Center wire  5. Crossover cable  

6. 30 feet 7. Infrared  8. Hot spot 

B. State true or false. 

1. True 2. False 3. False 4. True  5. False 6. True 

7. True 8. True 
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UNIT 2 
 

Chapter (6) – Cyber Security 

A. Choose the correct answer. 

1. a) Cyber-safety 

2. d) Online Advertising 

3. a) Trojan 

4. b) Phishing 

5.  c) hardware, software 

6. b) Internet fraud or scam 

7. a) Identity theft 

8. d) Socket 

9. c) Undesired emails 

10. a) Parents 

 

B. Short answer type questions. 

1. What is digital literacy? 

Home user, professionals, students, industries and government, everyone needs to have a fundamental 

understanding of cybercrime, online threats and their preventive and countermeasures. Knowing the 

threat and what to do once it occurs is the important part of digital literacy. 

2. How does a worm affect computer network or computer system? 

Worms are the program codes that replicate over a network from one computer to the other and make 

the computers slower and sluggish in speed. 

3. List various ways in which users are tracked online. 

IP Address, HTTP Referrer, Cookies, Fingerinting, User histroy tracking, online advertising, 

analytics. 

4. List 3 examples of anti-virus software. 

McAffee, Norton AntiVirus, eScan. 

5. What does spam filter do? 

Spam filter sends the undesired mails to the Spam folder. 
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6. List any 2 measures to protect against phishing. 

i. Never give away any sensitive information related to finance and security in reply to undesired 

emails and never on phone. 

ii. Always cross check the source of email and phone call with the concerned agency 

7. How will you identify that a website has SSL certificate. 

SSL websites have an icon of Closed padlock. 

8. How do online predators harm children? 

Online predators are individuals or groups who lure children into any unethical activity through 

games, live video chat, mind affecting videos and music, thought provoking speeches. Children suffer 

mental stress and sometimes nervous breakdowns due to threats. 

9. Define the term cyber-bullying. 

Any sort of threat, scare or harassment over internet is the act of cyber bullying. Undesired messages 

in bad taste and intentions, online mockery in friend groups or circles, stalking someone's online 

profile and trying to post unwanted updates, sending unsolicited private messages, videos, and 

pictures. 

10. List any 2 common measures for smartphone safety. 

Set up emergency numbers for instant calling. 

Do not use cell phone everywhere – keep your senses free to perceive other stimuli like while crossing 

road, driving, using escalators, crowded areas etc. 

C. Long Answer Type Questions. 

1. Briefly explain the terms: Cyber-safety, Cyber-Security and Cyber-crime. 

Cyber-safety generally refers to a set of discipline, measures and actions taken to protect personal 

information and your computer from attacks.  It also involves the practice to respect others' 

information privacy and not to indulge knowingly in divulging any information not meant for 

unauthorized entities. 

Considering the size, span, variety of technologies and devices, fighting and preventing cybercrime is 

a challenge. Policies, regulations, strategies and implementations of practices, discipline and 

technology to prevent or fight cybercrime is called cybersecurity. 

Unauthorised access to one's information online and exploiting it to bully, commit fraud and extortion 

is called cybercrime.  

2. How is your device uniquely identified on a network? 

Internet is “network of networks”. That means it is spanned all over the world with several networks 

connected to it. Across the world there are thousands of computers and other communication devices 

which are connected and online over the internet at a given point of time. Identifying each of these 

devices needs a system. IP address is that technology. IP address is a unique code assigned to each 
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device over a network.  One part of IP address identifies the netwrok and the remaining part identifies 

the device in that network. It is like Street Number and House Number. Network address is Street 

Number and device address is House Number. This way, IP address of user's device identifies that 

user on the Internet. 

3. What is the purpose of a cookie? Are cookies useful or harmful? Explain. 

Cookies or HTTP cookies is the most traditional and common way to track information about us such 

as website visiting time, duration and frequency, products added in the shopping cart while online 

shopping, data entered into form-fields like name, address, and passwords etc. Later, on next visit of 

the user such information is extracted from the cookies created during last visit on user's computer.  

Cookies are not harmful since they store small piece of information in plain text form which does not 

affect computers in any way. 

4. What do you mean by fingerprinting. What is the basic difference between active and passive 

fingerprinting? 

Techniques using fingerprinting tracking are done without storing cookies on user's device. Here, a 

user, device or combination is identified by the information that user reveals unsuspectingly. 

Fingerprinting can be done in two ways: 

Passive fingerprinting: In this technique, website visited by the user observesuser's browsing, the links 

and choices clicked and from that, create a unique identifier for the user-device combination. With 

this fingerprint, tracking websites follow users for longer periods of time. 

Active fingerprinting: In addition to passive fingerprinting, websites send some queries to the user's 

computer without user being aware about themand some of the information like name and version of 

the operating system and browser, fonts etc. is collected. 

5. How does a firewall protect a network? 

A firewall provides another level of protection to prevent incoming attacks. Operating system 

provides firewall protection which can be activated to filter unwanted access and attack to the 

computers over a network. Private networks use firewalls to keep unwanted IP addresses filtered out. 

A firewall provides a security combination of hardware and software that is used to protect a server 

and network resources from unauthorized access and intrusion. Firewall checks the incoming data 

packets over the networks and filters out which do not have suitable and sufficient permission to 

access the network. This way an extra level of protection is created right at the gates of the network.  

Hardware firewalls are more powerful and effective and they are easy to setup and configure. 

Hardware firewall is a dedicated computer that provides firewall protection to the network. Software 

firewalls needs to be installed on each computer. On a network, software firewalls are installed at the 

gateway server. 

6. What is the technique of eavesdropping called? How can we protect against it? 

Spyware is used for the purpose of eavesdropping. It installs itself on the computer without user's 

knowledge and monitors keystrokes, takes screenshots, reads chat, collects devise and user 

information and forwards it to the malicious owners of such program. 
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Protection 

I. Install an effective spyware detecting software. 

II. Keep your operating system and browser updated. Setup security settings the operating 

system and the browser. 

III. Check if any unnecessary software is being installed.  

IV. Carefully read and close any warning boxes that look like important messages. 

V. Be careful while installing free programs, games or shareware. Free programs may contain 

spyware.  

VI. Install a Firewall 

7. How can we protect ourselves against phishing and pharming? 

Never give away any sensitive information in reply to undesired emails and on phone.  

Always cross check the source of email and phone call. 

Look for misspelt words in URL. 

Download and use registered secured apps on your mobile phones like BHIM instead of unknown 

apps. 

Phishers address their targets with fancy terms like "valued customer" but genuine agency will 

address you by your correct name, username, customer ID etc. 

Phisher's message could be slightly rude in informing you cancellation or suspending your account.  

Install anti-phishing software. 

Regularly check your financial statements and account details. 

Always know where to report any such attacks immediately.  

Check the website's certificate icon of a closed padlock in the address bar. 

Update operating system, antivirus and browser. 

Websites should deploy effective firewalls. 

8. How online predators and cyber bullies affect young minds? 

Online predators lure children online whose young immature minds can be affected by unethical 

games, live video chat, mind affecting videos and music and thought provoking speeches. 

Cyber bullying threatens and affects young minds intensely even up to the threats of death. Undesired 

messages in bad taste and intentions, online mockery in friend groups or circles, stalking someone's 

online profile and trying to post unwanted updates, sending unsolicited private messages, videos, and 

pictures distress the children mentally.  

9. List any 5 effective ways to protect against identity theft. 

I. Keep track of your credit transactions and do not authorise anyone else to access yur card. 

II. Share information online with care. 
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III. Educate yourself about cyber frauds. Do not ignore but read and understand the security 

guidelines sent by authorized agencies like banks and government. 

IV. Avoid keeping sensitive information in the form of images and editable documents n a public 

domain. 

V. Avoid automatic online transaction settings. Always take pain of entering the details for each 

transaction. 

10. List any 5 ways to use your mobile phone responsibly. 

I. Set up emergency numbers for instant calling. 

II. Do not use cell phone everywhere – keep your senses free to perceive other stimuli like while 

crossing road, driving, using escalators, crowded areas etc. 

III. Get rid of unwanted data as soon as possible – keep your phone data tidy. 

IV. Protect your phone from physical theft. Make it a habit to check while leaving any place. 

V. Keep good password and pattern protection. Do not just rely upon face recognistion or voice 

activated locking apps. 
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UNIT 3 
 

Chapter (7) – Word Processor- OpenOffice.org Writer-I  

 

A. Choose the correct answer. 

1. (b) Writing 2. (d) Formula Bar  3. (b) Ctrl + N  4. (c) Copy, Paste 

5. (a) Find & Replace 6. (d) Beginning of line 7. (d) .doc  

8. (d) Ctrl + Shift + down 9.  (b) Spelling & Grammar 10. (c) Line Spacing  

11. (c) Text area 12. (d) Left 13. (a) Single-Spaced   14. (d) Letter    

15. (b) New, Open, Recent Documents, Wizards 

B. Short answer type questions. 

1. Word processor is an application software which is designed to create a document. This 

software allows a user to enter the text, to modify the text and format the text. In this 

software a user can also insert some graphics to make a document more attractive and 

presentable. 

2. Some commonly used word processors are Word Star, MS Word and OpenOffice.org 

Writer. 

3. In Word processor, a macro is a saved sequence of commands or keyboard strokes that 

can be stored and then recalled with a single command or keyboard stroke.  

4. When a user closes a document without saving it, all the text material and graphics 

content will be lost from that particular document. 

5. Using the "Save" command, we can save the changes in existing document. 

Using the "Save As" command, we can save the file new name (and location). 

6. Editing tool is used to edit a document in various ways like cut, copy , paste, undo, redo, 

find & replace, select all, etc. 

7. WYSIWYG is an acronym for "What You See Is What You Get". A WYSIWYG editor 

or program allows a user to see what the end result will look like while the document is 

being created. 

8. It is mandatory for a user to select the text before editing because if the text is not 

selected, the editing tool will not perform the functionality to edit the text. 

9. Undo reverses the previous editor action while Redo reverses an undo. 

10. Formatting is a process to change the look and appearance of the text by changing its 

color, size, font type and style. It is used to make a document more attractive and 

presentable. 

11. Paragraph space is the amount of space above or below a paragraph. Instead of pressing 

Enter multiple times to increase space between paragraphs, you can set a specific amount 

of space before or after paragraphs. 
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12. Margin refers to the blank white area near the edges (top, bottom, left and right) of the 

page in the document. 

C. Long answer type questions. 

1. The main parts of Writer window are, 

• Title Bar: It is located at the top of the window. It displays the name of the application 

and the document.  

• Menu Bar: It contains menus such as File, Edit, View, Insert, Format, Table, etc.  

• Standard Toolbar: It contains standard options like New, Open, Save, Cut, Copy, 

Paste, Spell Check, etc. 

• Formatting Toolbar: It contains formatting options like Font type, Font Size, Font 

style, Alignment, etc. 

• Ruler: The ruler is used to scale the document. There are two rulers- horizontal ruler 

and vertical ruler.  

• Scroll Bars: Scroll bars are used to navigate throughout the document. There are two 

types of scroll bars: horizontal scrollbar and vertical scrollbar.  

• Help: The Help option is used to show the help dialog box.  

• Text Area: The text area is used to create the document.  

• Status Bar: Status bar displays information such as current page, column, line number 

at which the cursor is currently placed, text insert mode, zoom percentage etc. 

• Zoom Control: It is used to increase or decrease view of the window contents. 

2. Writer provides Spelling and Grammar Checker which enables us to search for and 

correct all spelling and grammar mistakes in your document. Word is intelligent enough 

to identify misspelled or misused, as well as grammar errors and underlines them as 

follows. 

• A red underline beneath spelling errors. 

• A green underline beneath grammar errors. 

• A blue line under correctly spelled but misused words. 

The following methods to fix the spelling mistake are: 

Ignore: If you are willing to ignore a word then click this button and word ignores the 

word throughout the document. 

Add to Dictionary: Choose Add to Dictionary to add the word to the Word spelling 

dictionary. 

Change: This will change the wrong word using the suggested correct word. 

AutoCorrect: If you select a suggestion, Word creates an AutoCorrect entry that 

automatically corrects this spelling error from now on. 

3. Using Font tab on the Character dialog box we can format characters/text by setting 

appropriate values of various options. The Word processor provides ways to apply the 

various font formatting options (or character formatting options) to your text. Many of 

these options are displayed directly in the Font tab. 
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The formatting options that you can configure on the Font tab influence the appearance of 

the individual characters in your text. 

4. A Subscript or Superscript is a number, figure, symbol, or indicator that is smaller than 

the normal text and is set below or above the text. Subscripts appear at below the 

baseline, while superscripts are above the baseline. Subscripts and superscripts are best 

known for their use in formulas, mathematical expressions, and specifications of chemical 

compounds.  

 For example,  Superscript- (3)2 - (4)2 = (3 – 4) (3 + 4) 

    Subscript- H2O 

5. Alignment refers to the arrangement of the text and graphics relative to the margin. There 

are four types of paragraph alignment are available in Microsoft Word left-aligned, 

centered, right-aligned, and justified. 

Aligned Left: A paragraph's text will be said left aligned if it is aligned with left margin. 

Centered: A paragraph's text will be said center aligned if it is in the center of the left 

and right margins. 

Align Right: A paragraph's text will be said right aligned if it is aligned with right 

margin. 

Justified: A paragraph's text will be said justify aligned if it is aligned with both left and 

right margins. 

Alignment using Format menu:   

i. Put the cursor in the paragraph that is to be aligned. 

ii. Click on Format menu and select Paragraph option. 

iii. In the Paragraph dialog box, click on Alignment tab. 

iv. Click on the desired alignment option. 

Alignment using Format toolbar:     

i. Put the cursor in the paragraph that is to be aligned. 

ii. On the Format toolbar, click on the desired alignment option. 

6.  Paragraph Indentation determines the distance of the paragraph from either the left or the 

right margin. Within the margins, you can increase or decrease the indentation of a 

paragraph or group of paragraphs. 

 Before text: Before text indentation means to indent from the left page margin. 

 After text: After text indentation means to indent from the right page margin. 

 First Line: It specifies the first line indent. For positive indent we need to provide a 

positive value and for negative indent we need to provide negative. 

 Automatic: It automatically indents the first line according to the font size and lines 

spacing. Indent setting of First line box is ignored. 

D. Write the steps to do the following. 

Note: Practical steps. 
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A. Fill in the blanks. 

1. Word processor 2. Macro 3. Menu Bar 4. Deleting, moving and replacing  

5. Home  6. Location 7. Search  8. Character/ Text 9. Four  

10. Landscape & Portrait 

B. State true or false. 

1. True 2. True  3. True  4. False 5. False 6. False  

7. False 

C. Match the following. 

COL- I  COL-II 

1.      - Ctrl + Y 

2.    - Ctrl + N 

3.    - Ctrl + O 

4.    - Ctrl + S 

5.    - Alt + F4 

D. Below given are some navigation keys. Write their functions. 

1. Ctrl + Page Down- To scroll down the page. 

2. Ctrl + Left arrow- Moves the one word to left. 

3. Ctrl + Right arrow- Moves one word to the right 

4. Ctrl + Page Up- To scroll the page up. 

5. End- To move the cursor at the end of line. 

6. Ctrl + Home- Move the cursor beginning of the document. 

7. Ctrl + End- Move the cursor end of the document. 

8. Home- To move the cursor at the beginning of line. 

9. UP arrow, Down arrow- To move the cursor up and down. 

10. Left arrow, Right arrow- To move the cursor one character left or right.  

 

 

Chapter (8) – Word Processor- OpenOffice.org Writer-

II  

 

A. Choose the correct answer. 

1. (b) Headers and Footers 2. (a) Format → Bullets and Numbering  

3.   (d) Numbering Type 4. (c) Both a and b 5. (d) Insert → Picture  

6.   (b) Drawing Toolbar 7. (d) Tabular  8. (a) 2 columns and 2 rows  
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9. (c) Apply predefined table layout   

10. (d) To combine a document with data source and send the letters to several recipients. 

11. (a) Font Size 12. (d) File → Page Preview 13. (a) Total Pages 

14. (a) Set Page margin 15. (c) Insert → Object → Formula 

B. Short answer type questions. 

1. The different tools available in Bullets and Numbering Toolbar are – Bullets, Numbering 

Type, Outline, Graphics, Position and Options. 

2. Header is used to define additional information of the document at the top of page. For 

example, Date & Time, Author Name, Company Name, page number, etc.  While Footer 

is used to define the information at the bottom of the page. 

3. Drawing toolbar is used to insert some graphical symbols and shapes in the text 

document. It is helpful in colouring objects, inserting graphics and creating word art 

among other uses. 

4. Images in word document can be inserted in two ways –  

i. Click on Tools menu and choose the Gallery option.  

Or Click on Insert menu and choose the Picture → From File option. 

5. AutoFormat dialog box is used to apply elaborate format to the table.  

6. The different tools available in Print Preview toolbar are – Previous Page, Next Page, To 

Document Begin, To Document End, Page Preview: Two Page, Page Preview: Multiple 

Page, Book Preview, Zoom In, Preview Zoom, Zoom Out, Full Screen, Print Document 

and Close Preview. 

7. We can use mail merge tool to print a document with different recipients (addresses). 

8. Print Preview feature of Writer provides the facility to user to view (on the screen) what a 

printed version of the document would look like before printing a hard copy.  

To preview the document before printing, click on File → Page Preview option.  

C. Long answer type questions. 

1. A table is the way to present the data in rows and columns. Table is used to store the data 

in tabular format. It is used to see the details and compare the values.  For example, in a 

company the records of the employees can be maintained through tables.  

Steps to insert a table are: 

i. Click on Table menu → Insert → Table option. The Insert Table dialog box 

appears. 

ii. In the Insert Table dialog box, specify the following information: 

a) Type the table name in Name text box. 

b) In Size section, specify the number of columns and rows for the table. 

c) In Options section specify the Heading, Repeat Heading, Don’t split table, 

Border and AutoFormat properties. 

iii. Click on OK button. 
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2. Mail merge is a feature that produces multiple documents from a single template form 

and a structured data source. The letter may be sent out to many "recipients" with small 

changes, such as a change of address or a change in the greeting line. MS Word Mail 

Merge allows a user to send letters or documents to many people simultaneously; users 

simply create one document that contains the information that will be the same in each 

version, and then add placeholders for the information that will be unique to each version. 

The different components of mail merge are – 

Main Document -   This is the document contains the original message that needs to be 

sent to multiple persons. 

Data Source - It is a data base link that contains the personal information of the persons 

in tabular format. 

Merge Field – These are the fields that needs to be merged in main document from data 

source to insert the personal information of the recipient. For example first_name, 

last_name, address, ph_no, city, etc. 

Merged Document - This is the main document that contains the message and 

information of the recipient. 

3. Perform the following steps to create mathematical expression in the document: 

i. Click on Insert → Object → Formula option. 

ii. The equation editor opens with at the bottom of the document with Formula Elements 

window. 

 If Formula Elements window does not appear, click on View → Formula Elements 

option. 

 - Top of the Formula Elements window shows the formula or symbols. 

 - Bottom part shows the formulas or symbols available in the selected category (at the 

Top).   

 Now, type the equation in equation editor (for example, +a/a-b). 

iii. A box appears in the document containing the formula inserted in equation editor. 

After inserting the equation, click anywhere in the document, both equation editor and 

Formula Elements disappears.   

D. Write the steps to do the following. 

Note: Practical steps. 

 

A. Fill in the blanks. 

1. Bullets 2. Insert, default 3. Tools 4. Drawing 5. Table, Insert  

6. Don’t split table  

B. State true or false. 

1. False 2. True  3. False 4. True  5. False 6. True   

7. False 
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C. Match the following. 

 COL-I  COL-II 

 1.    - g. 

 2.   - e. 

 3.  - f. 

 4. - d. 

5. - h. 

6. - c. 

7. - b. 

8. - a. 

 

 
 

 

Chapter (9) – Presentation Tool- OpenOffice.org 

Impress  

 

A. Choose the correct answer. 

1. (b) Presentation 2. (c) Three Titles 3. (a) File → Wizard → Presentation   

4.   (c) F5  5. (a) Insert → Slide 6. (d) .odp 7. (a) Normal  

8.   (b) Handout View 9. (b) Drawing  10. (d) Spacing 11. (c) Fontwork Gallery 

12. (d) Both a and b 13. (d) None of these 14. (c) Sharpen 15. (a) Watermark  

16. (b) Custom Animation 17. (b) Custom Animation 18. (d) Slice 

B. Short answer type questions. 

1. While creating a new presentation a title can be inserted by changing its layout to the 

“Title Layout”. 

2. A slide layout is the arrangement of the items that form a slide, for instance, a title, 

graphics or text boxes. It contains the format, position and placeholders for everything 

that appears on a slide.  Name of 10 slide layouts out of available are – Blank Slide, Title 

Slide, Title Content, Title and 2 Content, Title Only, Centered Text, Title 2 Content and 

Content, Title Content and 2 Content, Title 2 Content over Content, Title Content over 

Content. 

3. Any five styles of slide transition are- Blinds Horizontal, Box In, Checkerboard Across, 

Comb Horizontal, Wipe Up. 
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4. Custom animation is used to apply different types of animation to the graphics, charts and 

pictures so that they become animated during a presentation. Many presenters make use 

of this feature so as to make their presentations interesting and dynamic. 

Different options available in custom animation are Add, Change and Remove the 

animation (effect), Set Start, sound (using Property) and Speed properties.  

5. A new slide can be inserted in the presentation by clicking on Insert menu and choose the 

new slide option. OR By pressing CTRL+N key from the keyboard. 

6. To delete a slide from the presentation, select the slide in the Slide pane and press Delete 

key on the keyboard. 

7. Sound and timing on an object can be applied by using the Modify effect pane in custom 

animation. 

8. Rehearse Timings Tool is used to insert the timings for a slide to be appear on the screen 

during the slide show view. 

9. Graphics mode in Picture toolbar is used to adjust the graphics mode of a picture in a 

slide i.e. default, grayscale, black/white and watermark. 

C. Long answer type questions. 

1. The components of Impress window are- 

i. Title Bar - It display the name of the current presentation. 

ii. Menu Bar - It displays the various options like File, Edit, Insert, Format etc. 

iii. Toolbars – They contain the shortcut buttons of various commands available in 

options of menu bar. 

iv. Slide Pane - The Slides pane contains thumbnail pictures of the slides in your 

presentation, in the order they will be shown. 

v. Task Pane - It has the various panes, such as Master Pages, Layouts, Table Design, 

Custom animation and Slide Transition, etc. 

vi. Slide View - This contains the different views to see the presentation i.e. Normal, 

Slide Sorter, Outline, etc. 

vii. Workspace – It display the current slide according to a selected view.  

viii. Drawing Toolbar - This toolbar contains various graphical objects i.e. textbox, 

shapes, etc. 

ix. Status Bar - The status bar, positioned at the bottom of the Impress window, contains 

information that you may find useful when working on a presentation. 

2. A slide view is the way to view the content on a slide. Different types of slide views in 

Impress are –  

i. Normal View: It allows inserting text, graphics, objects and animation effects in the 

slide. It is the default view in which a presentation is opened. 

ii. Outline View: It shows the contents of all the slides in outline form. This view is 

used to editing of the text only. 

iii. Notes View: This view is used to add some notes related to the slide. These notes will 

not be displayed in the slide show. 
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iv. Handout View: This view is used to adjust some slides on a single page which is 

meant to be printed. 

v. Slide Sorter View: This view shows all the slides that you have created in a small 

size. You can quickly look at and recognize all the slides and rearrange them 

according to your requirement. 

vi. Slide Show View: In a slide show all the slides in your presentation are displayed one 

by one in full screen. A slide show can be a very useful tool for teaching, sharing and 

learning. 

3. A Filter tool in the picture toolbar is used to format a picture according to the user 

requirement. It has the various options to change the look and appearance of the picture. 

Different tools available in Filter tool are –  

 

 
Invert Inverts the color values of a color image, or the 

brightness values of a grayscale image. 

 
Smooth Softens the contrast of an image. 

 
Sharpen Increases the contrast of an image. 

 
Remove 

noise 

Removes single pixels from an image. 

 
Solarization Mimics the effects of too much light in a picture. A 

further dialog opens to adjust the parameters. 

 
Aging Simulates the effects of time on a picture. Can be 

applied several times. A further dialog will open to 

adjust the aging level. 

 
Posterize Makes a picture appear like a painting by reducing the 

number of colors used. 

 
Pop Art Modifies the picture dramatically. 

 
Charcoal 

Effect 

Displays the image as a charcoal sketch. 

 
Relief A dialog is displayed to adjust the light source that on 

turn will create the shadow and hence the relief effect. 

 
Mosaic Joins groups of pixels into a single area of one color. 

 

D. Write the steps to do the following.  

Note: Practical steps. 

 

A. Fill in the blanks. 

4. Slides 2. Different   3. Title and 2 Contents 4. F5  5. View  

5. Delete 
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B. State true or false. 

1. True 2. True  3. False 4. True  5. True  6. True 

7.   False 

 

Chapter (10) – Spreadsheet- OpenOffice.org Calc  

 

A. Choose the correct answer. 

1. (c) 1048576, 1024  2. (d) None of these 3. (b) Right 4. (b) A, 1 5. (c)  = 

6. (c) + 7. (d) =A2*b2  8. (d) Both a and c 9.  (d) A1:C10   

10. (a) Cell Name box  11. (b) .ods  12. (d) Entire Sheet  

13. (a) Relative cell reference 14. (d) B5*$A$4 15. (b) Function size  

16. (a) Maximum value 17. (c) Image Function 18. (d) Delete All  

19. (d) Count  20. (c) Footer 

B. Short answer type questions. 

1. Fill handle tool is used to generate a series of data automatically. 

2. In a spreadsheet A2:B6 indicates a range of selected cell. That is starting from column 

‘A’ row ‘2’ and ending at column ‘B’ row ‘6’. 

3. Different options available on Formatting toolbar are Styles and Formatting, Font name, 

Font Size, Bold, Italic, Underline, four options of text alignment, Merge Cells, five 

options of number formatting, Decrease Indent, Increase Indent, Borders, Background 

Color and Font Color. 

4. In a cell text and value can be aligned horizontally and vertically. In horizontal alignment 

text can be aligned left, right, center and justify. In vertical alignment text can be aligned 

top, bottom and center. 

5. The options available in Insert Cells dialog box are – Shift cells down, Shift cells right, 

Entire row and Entire column. 

6. The output will be 19.3880597. 

7. The output of this formula will be 12. 

8. This formula is the example of mixed referencing. 

9. The output of this formula will be “False”.  

10. A chart is a pictorial representation of data which help in evaluating the worksheet and 

analyze them conveniently.  

C. Long answer type questions. 

1. Spreadsheet is an electronic sheet that is made of rows and columns. It is used to store the 

data in tabular format. The main application of the spreadsheet software is allow a user to 

enter the value in cell and perform the large calculations, analyze of data, preparing 

reports, charts and graphs etc. The electronic spreadsheet provides several advantages. It 

is quite big in size and can store large amount of information. Any part of worksheet can 
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be viewed, edited and printed. Data can also be viewed in pictorial form by using charts 

and graphs. With electronic sheet one can easily get formatted reports. Some examples of 

spreadsheet usage are- 

i. Spreadsheets act like a calculator automatically while doing calculations. 

ii. Spreadsheets are used for tracking personal investments, budgeting, invoices, 

inventory tracking, statistical analysis, numerical modeling, address books, telephone 

books, printing labels, etc. 

iii. Spreadsheets are used in almost every profession to calculate, graph, analyze and 

store information 

iv. Spreadsheets are made up of columns, rows, and cells (intersection of a column and 

row. A cell can contain data including text (strings or labels), numeric data and 

formulas (mathematical equations). 

2. In Calc, there are some predefined operators to perform calculations. The addition, 

subtraction, multiplication and division operators return numerical results. The Negation 

and Percent operators identify a characteristic of the number found in the cell, for 

example -37. The example for Exponentiation illustrates how to enter a number that is 

being multiplied by itself a certain number of times, for example 23 = 2*2*2. 

Operator  Name  Example  

+ (Plus)  Addition  =1+1  

- (Minus)  Subtraction  =2-1  

- (Minus)  Negation  -5  

* (asterisk)  Multiplication  =2*2  

/ (Slash)  Division  =10/5  

 % (Percent)  Percent  15%  

^ (Caret)  Exponentiation  2^3  

 

3. Editing - When it comes to editing the contents of a cell in Excel you have a number of 

different options depending upon whether you wish to completely replace or just modify 

the current contents. To work with data on a worksheet, you first have to enter that data in 

the cells on the worksheet. Then, you might want to adjust the data so that it is visible, 

and display it just the way that you want. Editing in spreadsheet can be done in many 

ways i.e. Replace the Current Cell Contents with New Data, Change Part of the Cell 

Contents, Copy contents of a cell. Move the contents of a cell, Delete the contents of a 

cell etc. 

Formatting - Formatting means the general arrangement of data. With formatting we can 

make some data to be bolder, rotated or in different color. So basically formatting 

provides worksheet a neater and more attractive look. 

4. Difference between terms –  

a. Difference between Relative and Absolute cell reference.  
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Relative Reference Absolute Reference 

A relative reference occurs when a 

cell is entered in a formula without 

using the $ symbol. For example, =A1 

An absolute reference occurs when a 

cell is entered in a formula using the 

$ symbol. For example: =$A$1 

When you copy/move the formula to 

another cell, Excel would not change 

the reference, excel will always refer 

to this specific location, no matter 

where this formula gets copied or 

moved. 

It means that if you copy the formula 

to another cell up & down and 

sideways all the REFERENCES of the 

formula will also move a 

corresponding number of cells up & 

down and sideways. 
 

b. Difference between Mixed and Absolute cell reference. 

Absolute Reference Mixed Reference 

An absolute reference occurs when a 

cell is entered in a formula using the $ 

symbol.  

A mixed cell reference then, is a 

combination of relative and absolute 

cell references. 

When you copy/move the formula to 

another cell, Excel would not change 

the reference, excel will always refer to 

this specific location, no matter where 

this formula gets copied or moved. 

As with absolute cell references, the 

dollar sign ‘$’ is used in mixed cell 

references to indicate that a column 

letter or row number is to remain 

fixed when a copied from one cell 

to another. 

 

For example: =$A$1 Examples of a mixed cell reference 

would be $E4 or F$6. 

For $E4, the column letter is fixed 

while the row number is allowed to 

change when copied to other cells. 

For F$6, the row number is fixed 

while the column letter changes. 
 

c. Difference between Sum() and Average() function . 

SUM Function AVERAGE Function 

The sum() function provides a quick 

way to add up the values in a 

spreadsheet entered in rows and 

columns. The SUM function adds all 

the numbers that you specify as 

arguments. Each argument can be a 

range, a cell reference, an array, a 

constant, a formula, or the result 

from another function. 

Syntax - SUM(number1, 

[number2], [number3], [number4], 

...)  

Average, is the arithmetic mean, and is 

calculated by adding a group of 

numbers and then dividing by the 

count of those numbers. For example, 

the average of 2, 3, 3, 5, 7, and 10 is 

30 divided by 6, which is 5. 

Syntax - AVERAGE(number1, 

[number2],...) 
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d. Difference between Max() and Min() function. 

MAX() MIN() 

The MAX function can be used to 

find the largest or maximum number 

in a given list of values. 

The MAX function can also be 

combined with other functions, such 

as the IF function, to create a 

conditional MAX-IF formula that 

find's the largest value for only those 

numbers in a list that meet conditions 

that you specify. 

Syntax - MAX(number1, 

[number2], ...) 

The MIN function is used to find the 

smallest or minimum value in a range 

of data. 

If the range selected for the function 

contains blank cells or cells 

containing text data, these cells are 

ignored by the function 

Syntax -  =MIN ( argument1, 

argument2, ... argument30 ) 

 

e. Difference between Column and Pie chart. 

Column Chart Pie Chart 

A bar chart shows bars with varying 

heights to represent different subjects. 

A pie chart is round, with the different 

subjects split into wedge shapes. 

In bar graph it presents the data in a 

linear format. you get precise 

statistics that way, using the x and y 

axis’s. Bar graph's better if you want 

to be specific. 

In pie chart they give you a circle, and 

then give you fractions of the circle, 

each representing a different option. 

Usually used to show a big difference 

between options. 

A bar chart does that but also shows 

you the distance between each %. 

A pie graph will help you understand 

how much of each % 

 

5. Different parts of a chart are the following- 

Chart Title - This is the descriptive text aimed at helping user identify the chart. 

Y-axis title - This is the name of vertical axis. 

X-axis title - This is the name of horizontal axis. 

Legend - The legend help you identify various plotted data series. Each series can be 

uniquely identified by assigning a unique color or pattern. 

Y-axis - This is the horizontal axis known as category axis. 

X-axis - This is the vertical axis known as value axis. 

Data Series - This is the set of values you want to plot in the chart. 
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Gridlines - These are the horizontal and vertical lines in the plot area. The gridlines are 

inserted in the chart to enhance the readability. 

Plot area – This is that area of chart in which your data is plotted.  

6. The IF() function returns one value if a condition you specify evaluates to TRUE, and 

another value if that condition evaluates to FALSE. For example, the formula 

=IF(A1>B1;"Cell 1 is greater";"Cell 2 is greater") returns "Cell 1 is greater" if A1 is 

greater than B1, and "Cell 2 is greater" if A1 is less than B1. 

Syntax - IF (logical_test; [value_if_true]; [value_if_false]) 

=IF(A1>B1;"Cell 1 is greater";"Cell 2 is greater") 

The IF function syntax has the following arguments: 

logical_test - Any value or expression that can be evaluated to TRUE or FALSE. For 

example, A1>B1 is a logical expression; if the value in cell A1 is greater than B1, the 

expression evaluates to TRUE. Otherwise, the expression evaluates to FALSE. This 

argument can use any comparison calculation operator. 

value_if_true - Optional. The value that you want to be returned if the logical_test 

argument evaluates to TRUE. 

value_if_false - Optional. The value that you want to be returned if the logical_test 

argument evaluates to FALSE. 

D. Write the steps to do the following.  

Note: Practical steps. 

A. Fill in the blanks. 

1. Workbook  2. Cell  3. 1048576, 1024  4. Cell reference 

5. Cell Name Box 6. Functions 7.  Formula   8. Chart 

B. State true or false. 

1. True 2. True  3. False 4. False 5. True  6. True 

7. True 8. True 



  Computer Applications CBSE Code 165 

 

39 

 

UNIT 4 
 

Chapter (11) – Scratch  

A. Choose the correct answer. 

1. d) software 2. b) sprites 

3. a) blocks 4. a) 0, 0 

5. c) event 6. b) looping 

7. d) Control 9. a) stop 10. b) if, if-else 

B. Short answer type questions. 

1. What is the difference between a block and sprite? 

Sprites are various objects that together make your animation and found in Sprites library while 

Blocks are the building components of the animation script. 

2. What is the use of Motion blocks? 

Motion blocks help in moving the sprites in different ways. 

3. Which blocks help in handling events in scripts. Give 3 examples of such blocks. 

Event blocks help in handling events in scripts like When this sprite is clicked, when ___ pressed, 

when animation button (flag icon) is pressed. 

4. How will you make a sprite move 100 steps. 

By using Motion block Move ___ steps and setting steps to 100.  

5. How will you make a sprite say “Hello”. 

By using Looks block say and setting the text to “Hello”. 

6. How will you add two sprites from People category in sprites library? 

Above the Sprites pane, click on Sprites from library icon. Sprites library will be displayed where 

sprites are organized in various categories. Click on People category and double click on the desired 

sprites to add them to the stage. 

7. Explain division Operator block with an example. 

Division operator block ____/____ takes two values or variables and returns the division between the 

two. 
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8. What is the basic difference between if-then and if-then-else block? 

The statements in if-then block execute only if the condition associated with it is true. if-else block 

has two parts: if and else. Statements in the if part execute only if the condition associated with it 

returns true. If condition returns false then the statements in the else part are executed. 

9. Explain the coordinate system of the stage in Scratch. 

Coordinate system on Scratch stage is Cartesian coordinate system that includes 2 coordinates - x 

(horizontal plain) and y (vertical plain). 

The center of the stage is denoted with x=0, y=0. The screen is a rectangle of dimensions 480 X 360. 

Across the horizontal plain, maximum value of x is 240 and minimum is -240. Across vertical plain, 

maximum value of y is 180 and minimum is -180. 

Center of the stage (x=0, y=0) is also called the Origin. 

10. How will you run certain statements in Scratch infinitely?   

To run certain statements in Scratch infinitely we need to place the required statements in forever 

block. 

C. Long answer type questions. 

1. Describe the role of stage and sprite in writing your script in Scratch. 

Stage is the place where animated output of the script is displayed. All the sprites are placed on stage 

and they appear according to the flow of the scripts. Coordinate system on Scratch stage is Cartesian 

coordinate system that includes 2 coordinates - x (horizontal plain) and y (vertical plain). 

The center of the stage is denoted with x=0, y=0. The screen is a rectangle of dimensions 480 X 360. 

Across the horizontal plain, maximum value of x is 240 and minimum is -240. Across vertical plain, 

maximum value of y is 180 and minimum is -180. 

Center of the stage (x=0, y=0) is also called the Origin. 

2. Describe any two commonly used blocks in Motion, Event and Control categories. 

Motion blocks:  

move ____ steps – This block takes a number as value of the steps to move the sprite. Sprite moves in 

a particular direction. 

point in direction ____ block – This block turns the sprite into these 4 directions: 90 (right), -90 (left), 

0 (up), 180 (down). Before moving the sprite, we can turn the sprite in desired direction using this 

block. 

Event blocks: 

when ____ is clicked – This block allows running the script by the press of given key on the 

keyboard. User can select the required alphabet, arrow key, space bar etc. from the drop-down list of 

choices. 
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when this sprite clicked – We can use this block when script needs to be run when user clicks with 

mouse on the corresponding sprite.  

Control blocks: 

repeat ___ - This block executes the given statements repeatedly as many times as the value set by the 

user. 

forever – This block executes the given statements repeatedly until the script is forcefully closed or 

any stop block is encountered. 

 3. What is the basic difference between turn block and point in direction block?  

Turn block turns the sprite around by given degrees while point in direction block turns the sprite in 

only one of the 4 directions - 90 (right), -90 (left), 0 (up), and 180 (down). 

4. What do you mean by decision making? 

To control the flow of animation many times certain checks need to be done and depending on the 

situation or scenario the change needs to be brought in the animation.  

Checking certain condition and deciding the course of the script is called taking decisions. For 

example, we can check the direction of the sprite and if it is not moving in the desired direction, we 

can change it. Similarly, we can check for the size, position or costume of the sprite. 

Decisions can be taken in Scratch using two blocks: if and if-else. 

5. What is a loop? What are the 2 types of loops provided by Scratch? 

Executing any statement repeatedly is called reiteration or looping. Scratch provides two types of 

loop. 

repeat ___ - This block executes the given statements repeatedly as many times as the value set by the 

user. 

forever – This block executes the given statements repeatedly until the script is forcefully closed or 

any stop block is encountered. 

6. What is meant by an event in Scratch? Explain with an example. 

An event is any action occurring at any point of time before, after or during animation. For example, 

user clicks on stage, a key is pressed on the key board, when green flag (play animation) button is 

clicked etc. 

Scratch lets us decide what to do when a particular event occurs. For example, if a sprite is moving 

and user clicks anywhere on the stage, we can decide to stop the animation or let the sprite do 

something. 

The basic approach towards event handling is to identify the logical sequence of actions to be 

performed when a particular event should occur and attaching the set of blocks of such actions with 

the suitable event block. 

For example,  
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From Scripts tab >Events category add when this sprite clicked block to your script. 

From Script tab >Motion category add move 100 steps. 

The above script will move the sprite 100 steps only when mouse is clicked on the sprite itself. 

7. What is a variable? How will you create a variable in Scratch? 

A variable is the storehouse for a value at a time. Variables in a script have unique names given by us. 

If variable stores a new value then any value previously stored in it is lost forever hence it is called a 

variable because during the course of the script its value may change. 

To create a variable, In Scripts tab, go to Data category.  

Click on the option Make a variable. 

In the dialog box, enter the desired name of the variable. 

Click on OK. 

Variable will be seen created. A checkmark besides it will show the variable on the stage. 

8. Explain the use of if-else block with an example. 

if touching color red then 

point in direction 0  

move 100 steps 

 

In the above script, it is assumes that the script is written for sprite named Mouse and the other sprite 

is red ball. Mouse is moving towards the red ball. When Mouse comes so closer to the red ball that it 

touches the ball (red colour), it will turn upwards and move 100 steps up. 

Here, checking of touching the colour is done by if block. The condition touching color red will return 

true only when Mouse touches the red ball. 

9. Write a short note on pen blocks. 

Pen blocks are used to draw simple figures. pen down block sets the pen ready to draw and pen up 

block unsets the pen to draw. Drawing is done by moving the sprite in different directions to get the 

desired figure. Pen blocks also allow setting and changing the pen colour and size etc. 

Erase all — Clears all pen marks on the screen 

Pen Down — Turns the pen feature on inside a sprite; the sprite will pen on the screen wherever it 

moves until the pen is turned off 

Pen Up — Turns the pen feature off, stopping a sprite from penning 

Set Pen Color to — Sets the color of the pen to a color chosen by the programmer 

Change Pen Color by  — Changes the pen color by a certain value 
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Set Pen Color to  — Sets the color of the pen to a color chosen by the programmer using a number 

system 

Change Pen Shade by  — Changes the shade of the color by a chosen value 

Set Pen Shade to  — Sets the shade of the color to a chosen value 

Change Pen Size by  — Changes the size of the pen by a chosen number 

Set Pen Size to  — Sets the size of the pen to a chosen number 

Stamp — Draws a copy of the Sprite on the Stage 

10. How will you terminate an infinite loop? Explain with an example. 

Infinite loop is implemented by the help of Control block forever. Statements inside forever block are 

executed infinitely so at certain point of time it needs to be terminated. To achieve this, we need to put 

a stop block after checking some condition. For example, following forever block will terminate and 

sprite will stop when the value of the variable M becomes 1000. 

forever 

 move 100 steps 

 if M = 1000 then 

  stop all  

D. Fill in the blanks: 

1. animation 2. Sprites 

3. Library  4. x 

5. looks  6. event 

7. down  8. repeatedly 

9. sensing  10. variable 

11. answer  12. less than 

13. ungroup  14. wait 

 

Chapter (12) – Introduction to Python  

A. Choose the correct answer. 

1. c) interpreted 

2. c) Interactive, script 

3. a) Python shell 

4. b) # 

5. d) No output 
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6. a) dynamically typed 

7. a) string 

8. b) floats 

9. c) strings 

10. b) + 

B. Short answer type questions. 

1. List any 5 features of Python. 

It is an easy to learn, write and read hence most suitable for programming begiinners. 

Programs written in Python can run on all modern platforms like Windows, Linux and Mac. 

2. What is the basic difference between Interactive mode and Script mode? 

In interactive mode user keys in one command at a time and in response to theat command Python 

displays the output. The commands are issued at Python command prompt denoted by >>>. For 

example, If you type: (1 + 7) * 2 

Then, immediately the result 16 will be displayed. Then you issue next command, get its output and 

so on. Interactive mode does not save your commands for later use. 

In script mode, the python commands are saved in a logical order to get the desired output. This 

logical set of instructions is called script. Once the script is saved, it can be executed anytime. 

3. How will you accept the name of the user using raw_input()? Write complete script. 

n = raw_input(“Enter your name: “) 

4. How floats are different from integers? 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. Floats store values up to 15 decimal places. 

5. What do you mean by operand and operator? Give example. 

Arithmetic operations involve two parts – operands and operators. Operands are the values on which 

arithmetic operation is performed and operators are the symbols that denote a particular operation. For 

example,  a = 5 + 2  Here, 5 and 2 are operands and + sign is addition operator. 

6. Explain the dual role of + operator. 

+ operator functions as addition operator with numeric values and as concatenation operator with 

strings.  

7. How will you convert integer into string and vice versa? 

str() converts numeric value into string. For example, 

price = 366.54 
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str_price = str(price)  str_price will have string 366.54 

 

int() converts given string into number. 

age = “65” 

iage = int(age)  iage will have number 65 

8. What is the use of ** and * operators? 

** is exponent operator. For example, 

a = 2**3 will return 8 (2 exponent 3) in variable a. 

* operator is multiplication operator. For example,  

a = 2 * 3 will return 6 in variable a. 

9. What is complex data type? 

The fields of engineering, advanced science and advanced mathematics deal with complex numbers. 

They are used in the scientific description of the phenomena and world around us. Complex numbers 

have no relevance at this level here so we shall leave complex numbers out. 

10.  Why floats are called real numbers and not integers. Give example. 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. For example, 

a = int(14.55) will return 14 only and a will be of number type because integer discards decimal 

places. 

C. Long answer type questions. 

1. Describe various data types in Python. 

Text or strings 

In computer programming terminology, text is called string. Strings are always enclosed in double 

quotes. When computer or Python interpreter encounters any value that is in double quotes, it treats it 

as string. For example: "I am a Python fan", "My country India", "123", "920431143" etc. Did you 

notice last two values? "123" is not One hundred twenty three. It is a string to be read as: one two 

three. For computer it is not a number because of double quotes. Hence, "123" and 123 are different.  

Numbers or Integers 

Numbers are not enclosed in any quotes. So, 123 is one hundred twenty three. 17 is seventeen. 

There are certain variants of number type like int, long and complex. 

Int: These are plain positive or negative whole numbers like your age, your height, distance between 

your house and your school etc. 
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For example: 

age = 12 

height = 10 

marks = 83 

Integers occupy 4 bytes in the memory to represent the value. So, all the variables above are of 4 

bytes size.  

Long: Numbers with huge values like distance between the earth and the sun, long scientific numbers 

are treated as long. Long integers occupy as much space in memory as the system on which the script 

runs allows. To denote that a number should be treated as long, the values should be suffixed with 

letter L. 

For example: distance_from_sun = 149L 

Here, the variable distance_from_sun will be allocated more than 4 bytes by the system. 

Complex: The fields of engineering, advanced science and advanced mathematics deal with complex 

numbers. They are used in the scientific description of the phenomena and world around us. Complex 

numbers have no relevance at this level here so we shall leave complex numbers out. 

Boolean: A Boolean value is either true or false. Booleans are treated as integers by the computer. 

False is denoted by 0 and True as 1. 

Floats 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. Floats store values up to 15 decimal places 

which is quite sufficient for majority of fields of computer programming.  

The distance between the sun and earth is 149.6 million kilometers but in previous example of 

integers, we could only store 149 which is approx. value. A floating point type variable can store 

precise value: 

distance_from_sun = 149.6 

Numbers with scientific notations like exponents indicating power of 10 are also represented by 

floating point numbers: 

x = 7.8e3 

This translates to 7.5 X 103 

2. List the features of Python language. 

Python was developed by Guido van Rossum, and it is free software in the early 1990s. Python is an 

interpreted language with dynamically typed variables which means variables in Python do not have a 

defined type like in C++ or Java. Python has a rich set of built-in collection types like Lists, Tuples, 

Dictionaries and Sets etc. An interpreted language is translated and executed statement by statement 

until the end of the program or until any error is encountered. It is not like a compiler based language 
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where program gets compiled into executable code by removing any errors first and then the compiled 

code is executed.  

Features of Python 

Python is open source programming language. You do not need to buy any license to use it. 

Download it and start using it just for free.  

It has features of both Object Oriented Programming languages like Java and C++ as well as 

procedural languages like C. 

It is an easy to learn, write and read hence most suitable for programming begiinners. 

Programs written in Python can run on all modern platforms like Windows, Linux and Mac. 

Python has a large, rich set of libraries to develop complex applications quickly and easily. 

Programs written in Python can be integrated with C++ and Java with least modifications. 

3. How will you create and run a Python script using IDLE and Script editor? 

Start IDLE 

Go to File menu and click on New File. This will open the editor. 

In the editor, type your program as below: 

Print( "Welcome to Python.") 

In the editor, go to File menu and click on Save. Type in myscript1.py and save the file in desired 

location. 

To run your program, in the editor, go to Run menu and click Run Module or alternatively you can 

press F5. This will run your file and the output will be displayed in shell. 

4. What is a variable? How will you accept a value from the user into a variable? 

A computer program written in any language takes some input, processes it and generates the output. 

These values are stored in variables which are identified by unique names in the program. A variable 

stores one value at time. When a new value is stored in a variable the earlier value gets overwritten. 

As a program runs, the values in a variable might change hence the term variable – anything that may 

store different values but one at a time. 

Example 1: Calculate 25% discount on the given price. 

price = raw_input("Enter the price of the item: ") 

price = float(price) 

discount = price * 0.25 

price_after_discount = price - discount 

print("The price of the item is " + str(price)) 
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print("Price after " + str(discount) + " discount is " + str(price_after_discount)) 

Here, raw_input() asks the user to enter a price value. User enters 565.99. This is assigned to variable 

price. float()converts string type returned by raw_input() into float. Using multiplication operator * 

25% discount is calculated and assigned to variable discount. Then price after discount is calculated 

using – operator. Finally, the output is displayed wherein non-string values are converted into strings 

using str() and + operator is used for concatenation. 

5. What is the basic difference between raw_input() and input()? 

raw_input() returns the input from the user in the form of string. input() returns the input from the user 

too but before returning it converts the value into suitable data type. So, if user enters a non-numeric 

value, it will be returned as string but if any number is entered, input() will return it as integer. 

Similarly, any fractional value like 2.75 will be returned by input() as float. input() takes an optional 

parameter of string type which can be used to display a prompt for the user. 

For example: 

a = input("Enter a number:"); 

print(a * a) will display 25 if user enters 5. No data conversion is required, input() has returned the 

value as number. 

a = raw_input("Enter a number:"); 

print(int(a) * int(a)) will display 25 if user enters 5. Data conversion is required using int() since 

raw_input() has returned the value as string. 

6. Describe various arithmetic operators with one example each. 

 

7. Giving an example explain the implicit data type conversion in Python. 

During an arithmetic operation, if required, Python automatically does certain data conversion known 

as implicit data type conversion.  For example:  

a = 2 * 3.5 This will result into a float value automatically taken care of by Python. 
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8. What is the use of str() and int()? 

str() converts numeric value into string. For example, 

price = 366.54 

str_price = str(price)  str_price will have string 366.54 

 

int() converts given string into numeric value. 

age = “65” 

iage = int(age)  iage will have number 65 

9. What is concatenation? 

+ operator, besides being an addition operator on numeric values also serves as combining strings. 

For example, 

price = 345.99 

str_price = str(price) 

print("The price of the item is " + str_price) 

Here, str()is used to convert the float value 345.99 into string and then + operator is used to 

concatenate the two string. 

10. What is the role of comments in a script? 

Python Comments 

Comments are a way to document the script or put explanatory remarks to your script. Any line in 

Python code that begins with # sign is treated as a comment by the Python interpreter and it is not 

executed. 

For example: 

#Following script displays greeting to the user 

print("Welcome to the world of programming!") 

#print("This is not going to execute") 

Here, first line is a comment and informs what the script is doing to anyone who refers to it but notice 

the last line. Since it is also prefixed with # sign it will not be executed. 
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UNIT 1 
Chapter - 1- Introduction to the Internet 

EXERCISE 1 

A. Choose the correct answer. 

1. (b) HTTP 2.  (d) 1990  3. (b) HTML pages 4. (c) World Wide Web 

5.   (a) Gateway 6. (b) Internet Service Provider 7. (d) All of these 

8.   (c) ISP  9. (b) Unique Address  10. (a) Web Browser 

B. Short answers type questions. 

1. Although the primary application of all the web browsers is the same, they differ from 

each other in more than one aspect. The distinguishing areas are: 

• Text web browsers: - They support only text contents. 'Lynx' is a browser of this 

category. 

• Graphical web browser: - They are more advanced than text browsers. They support 

both text and graphical. 

2. The full form of IETF is Internet Engineering Task Force. 

3. Search engine is a program that searches the documents for specified keywords and return 

a list of the documents where the keywords were found. For example, Google, Bing and 

Yahoo! Search. 

4. ARPANET was a large wide-area network created by the United States Defense in 1969. 

Advanced Research Project Agency (ARPA).  The goal of this project was to connect 

computers at different universities and U.S. defense. 

5. A website address is known as URL (Uniform Resource Locator) on internet. It is a 

unique address of a website through which a user can access the web site over the internet 

through World Wide Web.  

6. Internet is known as International Network. It is a network of networks that is spread all 

over the world.  It is a global network of computer networks that connects different types 

of computer networks to exchange the information. 

7. Broadband is defined as a high bandwidth connection to the Internet. Broadband can 

make using the Internet in the home much easier, faster and more efficient. Broadband 
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can be provided over your phone line, via cable or via satellite. It involves large volumes 

of information being carried at high speeds to your PC. 

8. Short for Hyper Text Transfer Protocol, the underlying protocol used by the World Wide 

Web. HTTP defines how messages are formatted and transmitted, and what actions Web 

servers and browsers should take in response to various commands. 

9. A web site is a collection of World Wide Web (WWW) files that includes a beginning file 

called a home page. It is the combination of multiple web pages. 

C. Long answer type questions. 

1. A web browser is a software application designed to help you access information on 

the World Wide Web. At its most basic, a browser will: 

a. It allows you to enter the URL of the resource you wish to retrieve from the 

internet. 

b. Send a message to a server requesting that resource. 

c. Accept the resource when the server returns it. 

d. Translate the resource into a correctly laid out, viewable web page. 

2. A Web server is a computer that deliver (serves up) Web pages. Every Web server has 

an IP address and possibly a domain name. Any computer can be turned into a Web 

server by installing server software and connecting the machine to the Internet. It's a 

server used to communicate with Web Browsers as its clients and the communication 

protocol used in this case is HTTP (Hyper Text Transfer Protocol). 

3. You can use Internet in different ways: 

i. E-mail: By using internet we can communicate in a fraction of seconds with a 

person who is sitting in the other part of the world. Today for better 

communication, we can avail the facilities of e-mail. 

ii. Social Networking: Today social networking sites have become an important part 

of the online community. A number of people use this facility to remain in touch 

with their nears and dears.  

iii. E-Commerce (Online Shopping): In today's busy life most of us are interested to 

shop online. In countries like USA, most of consumers prefer to shop from home. 

We have many shopping sites on internet like amazon.com, snapdeal.com, 

ebay.com, flipcart.com, junglee.com, etc. Virtually anything can be bought or sold 

on the internet. 

iv. Entertainment: On internet we can find all forms of entertainment from watching 

films to playing games online. 

v. Information: Information can be taken on any topic on the internet. It can be 

from any source worldwide that has a presence on the Internet. For example, 

Agriculture Advisers, Colleges, Universities, Banks, Purchasers and Supply 

companies. 

vi. Business tools: Online management and business tools are very popular. For 

example, online banking or currency converters.  

vii. Discussion groups: It is used to exchange your views with others over the 

Internet about your interests and views. Discussion groups are also very famous 

now a days.   
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viii. Other Services: Many services are provided on the internet such as online 

banking, job seeking, purchasing tickets for your favorite movies, paying bills, 

etc. 

4. Electronic mail, e-mail or email is text messages that may contain files, images, or 

other attachments sent through a network to a specified individual or group of 

individuals. .It does the job of sending, receiving, storing as well as transferring files. 

Its functionalities are like an ordinary postal service. It also has got some special 

features such as you can store some of the emails, which is important, you can store 

all your friends email contact with their address. Some of the email service providers 

are Yahoo, Gmail, Rediffmail, Ymail, Hotmail. 

5. The World Wide Web (WWW) is one set of protocol (software services) running on 

the Internet. The World Wide Web is a subset of these interactions and supports 

websites and URIs.  World Wide Web can be termed as the software part – it is a 

collection of web pages connected through hyperlinks and URLs. Whereas, the 

Internet itself is a global, interconnected network of computing devices. This network 

supports a wide variety of interactions and communications between its devices.  

Internet is the hardware part - it is a collection of computer networks connected 

through copper wires, fiber optic cables or wireless connections. 

6. Dial-Up services use phone line and a modem. Your modem makes a phone call to 

the internet service provider's modems to connect, so you cannot talk on the phone 

while the internet is connected. Dial-up is one of the slowest types of service 

available, however it is one of the most readily available because it was designed to 

use basic services like the phone system that are already in place. Dial-up also 

requires you to connect every time you want to use it. 

Wireless services use radio signals from the ISPs tower to connect you to the internet. 

The signal goes to an antenna on your roof or on the side of your building via shielded 

cable to the radio. The radio is a small box that then connects to a computer or router. 

Wireless technology is mostly used in mobile phones. NOTE: if you are using a 

laptop or desktop that is wireless enabled, this is not the same type of wireless. This is 

a totally different system called WiFi or 802.11abg, which you put in your home or 

business to enable you to roam around your location and still have a connection. 

7. Dial Up - It uses your phone line and a modem. Your modem makes a phone call to 

the internet service provider's modems to connect, so you cannot talk on the phone 

while the internet is connected. Dial-up is one of the slowest types of service 

available, however it is one of the most readily available because it was designed to 

use basic services like the phone system that are already in place. Dial-up also 

requires you to connect every time you want to use it. 

Broadband - Broadband refers to a connection that has capacity to transmit large 

amount of data at high speed. Presently a connection having download speeds of 

256kbps or more is classified as broadband. With a broadband connection, phone line 

can still be used while using the Internet and both the phone and the Internet work 

simultaneously and no dialup costs are incurred. 

8. Internet was first developed in USA and used by the Department of Defense. This 

network was known as ARPANET which was established in 1969. This was regarded 

to be the first step towards the creation of the Internet. Internet, however, came to be 

used more widely in the 1990's and ARPANET was shutdown in 1990's. In 1991, the 

first friendly interface of the Internet was developed at the University of Minnesota. 
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9. A protocol is a set of rules that govern communication between computers. Protocols 

specify secure interactions between the communicating computer devices. A network 

protocol defines rules and convictions of communication between network devices. 

For example, FTP, TCP/IP, SMTP, HTTP, etc. 

10. The TCP/IP protocol is designed such that each computer or device in a network has a 

unique "IP Address" (Internet Protocol Address) and each IP address can open and 

communicate over up to 65535 different “ports” for sending and receiving data to or 

from any other network device. The IP Address uniquely identifies the computer or 

device on the network and a "Port Number" identifies a specific connection between 

one computer or device and another (i.e. between two IP Addresses). A TCP/IP "port" 

can be thought of as a private two-way communications line where the port number is 

used to identify a unique connection between two devices. The concept is very similar 

to any other type of port on your PC (serial, parallel, etc.) except that instead of 

having a physical connection, the TCP/IP protocol creates a "virtual IP port" and the 

network hardware and software is responsible for routing data in and out of each 

virtual IP port. 

EXERCISE 2 

A. Fill in the blanks – 

1. World Wide Web 2. Graphical 3. Web Browser 4. ISP  6. W3C 

7. 1990s   8. E-mail 9. Internet Service Provider  

10.  World Wide Web Consortium  

B. State true or false 

1. False  2. False  3. False  4. False 5.  False 

6. True  7. False  8. True   9.  True 10.  False 

 

 

Chapter - 2- Internet and Web Services 

EXERCISE 1 

A. Choose the correct answer. 

1. (a) FTP   2. (c) Web Browser 3. (b) File Transfer Protocol  

4. (c) Exploring the web 5. (d) All of these 6. (d) All of the above   

8. (c) abc@gmail.com 9. (c) More than 3 10. (d) None of these 

B. Short answers type questions. 

1. The devices, to connect the computer to internet, are - Computer System, Modem, 

Telephone connection from ISP. 

2. Different types of blogs are – personal, business, schools, non-profits, politics, 

military, etc. 

3. Some of the advantages of using e-mail are as follows: 
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• An e-mail is very fast. It is received and delivered within the seconds from 

anywhere in the world. 

• Sending and receiving an e-mail is very easy, low cost and convenient. Many 

types of files such as text files, audio, videos and images can be sent as an 

attachment through an e-mail. 

4. A search engine work with the help of three elements: 

• A software called spider or hot 

• Database 

• Search Algorithm 

 

5. Steps to send an e-mail are, 

(i) Open an email account and click on ‘Compose Mail’ button. 

(ii) Type the e-mail address of receiver. 

(iii) Type the subject name. 

(iv) Type the message and click on ‘Send’ button. 

6. The File Transfer Protocol (FTP) is a standard network protocol used to transfer 

computer files from one host to another host over a TCP-based network, such as the 

Internet. FTP is built on client-server architecture and uses separate control and data 

connections between the client and the server. 

Telnet is a network protocol that allows a user on one computer to log into another 

computer that is part of the same network. 

7. Two advantages of social networking are:  

• Stay in touch with others. 

• Ease of access to information and applications.  

8. FTP works on a principle of client-server model and uses data-connection between 

client and server. A Client makes a TCP connection to the server. This connection 

remains open for the duration of the session and thus is called a control session. 

9. VSNL and Airtel. 

C. Long Answer types questions. 

1. Blog - A blog is a frequently updated online personal journal or diary. It is a place to 

express yourself to the world. A place to share your thoughts and your passions. It 

displays the freshest information at the top. We can create blogs on Google, Yahoo, 

etc. 

E-banking – Electronic banking, also known as electronic fund transfer (EFT), uses 

computer and electronic technology in place of checks and other paper transactions. 

E-banking is performed through devices like cards or codes that let you, or those you 

authorize, access your account. A number of banks provide their online banking (e-

banking) solutions. For example, State Bank of India, Canara Bank, ICICI Bank, Axis 

Bank, Bank of India, etc.  

E-shopping - It is a form of electronic shopping through which a user can buy goods 

and services from merchants over the Internet. Shoppers can visit web stores from the 
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comfort of their homes and shop as they sit in front of the computer. A number of 

online shopping (e-shopping) sites are running on internet. For example, 

Snapdeal.com, Amazon.com, Flipcart.com, etc.  

2.  Steps to check e-mail in our mailbox are, 

(i) Open the browser and then e-mail service provider. 

(ii) Sign-in into e-mail account. The e-mail account interface appears. 

(iii)Click on the either name of the mail sender or subject of the mail. 

The mail appears in the interface window.   

3. E-Learning is electronic learning, in which the learner uses a computer to learn a task, 

skill, or process. It is also referred to as computer-based training, web-based training, 

and online learning. E-Learning can be even more effective than traditional, 

classroom learning. Advantages of e-learning are :- 

• Class work can be scheduled around work and family.  

• Reduces travel time and travel costs for off-campus students.  

• Students may have the option to select learning materials that meets their level of 

knowledge and interest.  

• Students can study anywhere if they have access to a computer and Internet 

connection.  

• Self-paced learning modules allow students to work at their own pace. 

4. Social networking means conglomeration of people forming small groups or 

communities. Social networking sites provide platform for staying in touch with their 

dear ones.  

A social networking service is an online service, platform, or site that focuses on 

facilitating the building of social networks or social relations among people who, for 

example, share interests, activities, backgrounds, or real-life connections. A social 

network service consists of a representation of each user (often a profile), his/her 

social links, and a variety of additional services. For example, Facebook and Twitter 

are two social networking sites. 

5. Five uses of Internet are:- 

i. Blog - A blog is an online personal journal or diary. It is a place to share your 

thoughts and your passions. It displays the freshest information at the top. 

ii. E-banking – We can operate our bank accounts on internet without going to the 

banks. A number of banks provide their online banking (e-banking) solutions.  

iii. E-shopping - It is a form of electronic shopping through which a user can buy 

goods and services from merchants over the Internet. Shoppers can visit web 

stores from the comfort of their homes and shop as they sit in front of the 

computer.  

iv. E-Learning is electronic learning, in which the learner uses a computer to learn a 

task, skill, or process. It is also referred to as computer-based training, web-based 

training, and online learning. E-Learning can be even more effective than 

traditional, classroom learning. 
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v. A social networking service provides platform that focuses on facilitating the 

building of social networks or social relations among people who share interests, 

activities, backgrounds, or real-life connections. 

6. Online reservation is a very useful and widely used feature on internet. It is a process 

through which a user can book the tickets for railways and airlines for the journey 

without going anywhere and can pay the money for the tickets also. Now a days, a 

user can book the hotel also. Advantage of Online reservation are following: 

• Speed: Booking online allows you to make your reservation efficiently. We can 

book rail, airline and hotel reservation on just a click through internet. 

• Convenience: You can book online anytime and anywhere. 

• Variety: By booking online, you can see a variety of lodging and flight options for 

a particular destination, without having to call around to hotels and airlines. 

Multiple options help to select best one.  

• Confirmation: When you book online, you have the satisfaction of knowing the 

reservation was made correctly. We can print out your confirmation, to avoid any 

type of problems to get to the hotel or airline. 

• Price: When you book ticket many airline provide ticket for a particular 

destination at different price. Online reservation provides facility to compare them 

and find a cost effective solution. 

7. SMTP (Simple Mail Transfer Protocol) is a set of communication guidelines that 

allow software to transmit email over the Internet. It's a kind of shorthand that allows 

a server to break up different parts of a message into categories the other server can 

understand. Most e-mail systems that send mail over the Internet use SMTP to send 

messages from one server to another. The messages can then be retrieved with an e-

mail client using either POP or IMAP. 

EXERCISE 2 

A. Fill in the blanks. 

1. E-mail  2. News Groups 3. FTP  4. Web site 5. E-mail  

6. Online reservation 7. ISP  8. Chatting  9. E-learning  

10. Social Networking 

B. State true or false 

1. False  2.  True 3.  False 4. True  5. True  6.  False 

  



  Computer Applications CBSE Code 165 

 

57 

 

 

UNIT 2 
 

Chapter – 3 - Introduction to HTML 

EXERCISE 1 

A. Choose the correct answer  

1. (a) Web Pages 2. (c) Assembler 3. (d) None of these  4. (b) Two  

5.   (d) All of these 

B. Answer the following questions  

1. HTML stands for Hyper Text Markup Language. It is a language that is used to design 

web pages by using some pre-defined tags. It is the extended version of SGML. HTML 

tells the browser how to display the various contents like text, images, graphs, audio file 

and video file on a web page.  

2. To design a HTML document a user requires three things –  

Text Editor - Text editor is a tool that provides a user to write a code in some specific 

markup language to design a web page. Different types of text editor are Notepad, 

Notepad++. 

Protocol (FTP client) - It is a protocol available in major operating systems.  

Web Browser - It is an application program that displays the output of an HTML 

program. 

3. Empty tag - In HTML, tags that have only opening tag are called empty tag. There is no 

closing tag. These tags do not act on blocks of text. 

Example :<HR>,<BR>,<IMG>,<LI> 

4. Container Tag - In HTML, tags that include both an ON and an OFF tag are called 

container tag. They hold or contain the text between the two tags (opening and closing). 

<Tag>text being formatted or defined</Tag> 

Example :<HTML>, <HEAD>, <BODY>, <CENTER> 

5. Tag - A tag is a predefined syntax in a markup language. It is a basic building block of a 

program. Each tag can also have content, including other tags and text. HTML tags 

represent semantics, or meaning. For example, the title element represents the title of the 

document. A tag name appears between the opening and closing < > brackets. For 

example <HTML> 

Attribute - Attribute is a property value that customizes or modifies an HTML element 

or tag.  For example - <BODY bgcolor=”#0000f0”>. Here ‘bgcolor’ is an attribute of 

<BODY> tag. 

6. The <body> tag defines the document's body. The <body> element contains all the 

contents of an HTML document, such as text, hyperlinks, images, tables, lists, etc.  

Example - <html> 

<body> 
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Document's content. 

</body> 

</html> 

<body> tag has various attribute to customizes or modify the web page. These attributes 

allow you to control the overall appearance of the document by specifying a background 

color or background image (BGCOLOR, BACKGROUND), and the color of text, links, 

visited and activated links (TEXT, LINK, VLINK, ALINK). 

7. The <center> tag is used to display the content of a web page on the center of the page. It 

is a container element. The content will appear between the opening and closing tag.   

<center> The text to be displayed will appear here. </center> 

EXERCISE 2 

A. Fill in the blanks. 

1. Hyper Text Markup Language 2. Tags  3. Editor 4.  Additional   

5. <BODY>  6. .html or .htm 7.  Web page  8. Note: correct sentence 

is --- The <title> tag is used to set the title of the web page. 9. <BR> 

B. Match the following.  

 Column A    Column B 

1. Heading tag  - d) <H1> 

2. Center object - a) <CENTER> 

3. Blank Line  - b) <BR> 

4. Web page body - e) <BODY> 

5. Title of web page - c) <HEAD>  Note: Correct ans. is <Title> 

C. State true false. 

1. True                     2. True   3. False  4. False 5. False 

 

 

Chapter – 4 - Formatting in HTML 

EXERCISE 1 

A. Choose the correct answers.  

1. (a) Attractive 2. (a) Font 3. (d) None of these 4. (c) Face 5. (b) &copy; 

B. Answer the following questions.  

1. Formatting a document is a very basic thing. Formatting is setting margins, tab positions,   

headers and footers for the entire document. It also entails defining heading styles, body 

text styles, spacing, justification, succeeding paragraph styles, text flow, etc. It is used to 

make the document more attractive and presentable. In HTML various types of 

formatting tags are <font>, <b>, <i>, <u>, <sup>, <sub> etc. 

2. Alignment is the part of formatting. It is used to set the position of text, image and graph 

on a web page. Different types of alignments in HTML are- 

Left – This alignment is used to set the position of text to the left hand side of the page. 
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Right – This alignment is used to set the position of text to the right hand side of the 

page. 

Left – This alignment is used to set the position of text in the center of the page. 

Justify – This alignment is used to set the position of text between both (left and right) 

the margins. 

Bold Tag <b> …..</b>- The text appears between the <b>……..</b> element will be bold and stand 

out against text around it. It is a container element. 

Example  -  <b> Edusoft Solutions </b> 

Output    -   Edusoft Solutions 

Italic Tag <i> …….</i>- The text appears between the <i>………….</i> element is displayed in italicized. 

It is a container element. 

Example  -  <i> Edusoft Solutions </i> 

Output     -  Edusoft Solutions 

3. Any five special characters with output symbols are: 

 

 

 

 

EXERCISE 2 

A. Fill in the blanks.  

1. Enter key 2. Under 3. Superscript 4. Bigger 5. 1, 7  

6. Color 7. Font  8. Fixed width  9. Symbol codes 

B.  State true or false. 

1. True 2. True  3. False 4. False 5. False 

C. Match the following. 

Column A   Column B 

1. &nbsp;  - b) Blank Space 

2. &trade;  - e) Trade Mark Symbol 

3. &divide; - d) Divide Symbol 

4. &reg;  - c) Registered Symbol  

5. &quot;  - a) Double Quotes 

Symbol Code Name 

(It’s there, but you can't see it!) &nbsp; non-breaking space 

& &amp; ampersand 

© &copy; copyright 

÷ &divide; divide 

> &gt; greater than 

< &lt; less than 

http://www.utexas.edu/learn/html/spchar.html#nbsp
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Chapter – 5 - Images, Links and Lists in HTML 

EXERCISE 1 

A. Choose the correct answer 

1. (d) Direction 2. (d) None of these 3. (a) Href 4. Two  5. (c) Size  

6. (d) All of these 7. (d) All of these 8. (b) DC 9. (d) All of these 

10.  (d) All of these 11. (a) Caption 12. (d) None of these  13. (b) Width 

14.  (b) Columns  

B. Answer the following questions 

1. In HTML, images are defined with the <img> tag. It contains attributes only, and has no 

closing tag.  

Attributes of <img> tag: 

Src- This attribute is used to display an image on the web page. This attribute contains 

the URL or address of an image as a value. 

Align -This attribute is used to set the position of an image in the web page. It has the 

value either “left”, “right” or “center”. 

Alt-This attribute specifies alternate text to be displayed if for some reason the browser 

cannot find the image. 

Height- Height attributes that define the height of an image. These values can either be 

percentage based (%) or rely on pixel sizes. 

Width -Width attributes that define the width of an image. These values can either be 

percentage based (%) or rely on pixel sizes. 

2. The HTML <a> tag defines a hyperlink. Attributes of <a> tag are: 

• Href - A HREF attribute in an anchor tag defines an “address” of the link. This 

address can be a webpage, image, sound, video or any other resource. 

• Target - Target attribute defines where to open the document/url, specified in ‘href’ 

attribute. 

 

• Name - A name attribute of anchor tag is used to define a named anchor. This named 

anchor is invisible to reader. 

3. Internal Linking - An internal hyperlink is one that takes us to a new location within the 

current open web page. Before we can establish an internal hyperlink first we must create 

either a 'bookmark'.  A bookmark defines the place within the text where we want to go. 

We do so by using the <A></A> anchor tags along with the NAME attribute. For 

example the header for this section is defined as a bookmark with the following HTML 

code: <a name="Internal Hyperlinks">Internal Hyperlinks</a>. 

A target attribute has following possible values 

• _top: Opens liked URL in same window using full body. 

• _self: Opens linked URL in same frame from which it is clicked. (it’s a default) 

• _blank: Opens linked URL in new window. 

• _parent: Opens linked URL in parent window/frameset. 
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External Linking - An external hyperlink is used to link the one document with another 

document. In this case the href attribute of <a> tag will include the full address of the 

remote resource using the URL. Example - <A href=”url”> Name of Hyperlink </A>. 

4. Different types of lists in HTML are – 

Ordered List - This list is also known as Numbered list (which uses an ordering system 

e.g., numbers, letters, etc.). Ordered lists are created using the <ol> tag (to define the list).  

Unordered List - An unordered list is an unnumbered list. Unordered lists simply have a 

plain bullet point for each item in the list. Unordered lists are created using the <ul> tag. 

Definition List - Definition lists are similar to other lists but in a definition list, each list 

item contains two or more entries; a definition term (<dt>) and at least one definition 

description (<dd>). Definition lists are created using the <dl> tag. 

5. Marquee Tag - Marquee tag is used to set a scrolling (vertically or horizontally) text or 

image. Using <marquee> tag we can set text/images scroll from right to left, left to right, 

top to bottom, or bottom to top.  Attributes of <marquee> tag 

• Direction -This attribute is used to set the direction of scroll. We can set direction as 

left, right, up and down. 

• Bgcolor- This attribute is used to change the background colour of marquee. 

6.  A table in HTML is used to display the data in the tabular format. It is made up of rows & 

columns. The HTML table model allows authors to arrange data -- text, preformatted text, 

images, links, forms, form fields, other tables, etc. -- into rows and columns. Each table 

may have an associated caption that provides a short description of the table's purpose. 

7.  The five child elements of <TABLE> tag are – 

 <CAPTION> - This tag is used to define the title of a table. 

 <TR> - This tag is used to create a new row. 

 <THEAD> - This tag is used to define the header of a table. 

 <TBODY> - This tag is used to define the body of a table. 

 <TFOOT> - This tag is used to define the footer part of a table. 

8.   The five attributes of HTML table are: 

• Border - This attribute places a border around the table and frames on each cell.  

• Bordercolor - This attribute will change the colour of the border. 

• Bgcolor - This attribute is used to change the background colour of a table. 

• Background - This attribute will set a picture as the background of a table. 

• Align - This attribute will set the position of the table on web page. It can have the 

value left, right or center. 

9. Table head <thead> is used to create a horizontal header over the complete width of a 

table. The <thead> element is used in conjunction with the <tbody> and <tfoot> elements 

to specify each part of a table (header, body, footer). Browsers can use this element to 

enable scrolling of the table body independently of the header. Also, when printing a 

large table that spans multiple pages, this element can enable the table header to be 

printed at the top of each page. 
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10. Rowspan & Colspan attributes- Table cells can span or merge across more than one 

column or row. Use rowspan attribute if you want to merge two or more rows. In Similar 

way, use colspan attribute if you want to merge two or more columns into a single 

column. Both the attributes takes number as a value for the number of columns and 

number of rows to be merged. Example – <td rowspan=“2”> cell data </td> 

<td colspan=“2”> cell data </td> 

EXERCISE 2 

A. Fill in the blanks.  

1. <img> 2. <a>  3. Internal, external 4. Target 5. Definition    6. Nested 

7. Motion 8. Scroll 9. Alternate 10. Rows, columns 11. <table> 

12. <table> 13. Bold 14. Rowspan 

B. State true and false. 

1. True 2. False 3. False 4. True  5. False 6. True   

7. True 8. True  9. False 

C. Write the full form of the following. 

a. Image b. Source c. Hyper Text Reference d. Unordered List e. List  

f. Ordered List g. Definition List h. Definition Description i. Definition Term 

j. Alternate  

 

  Chapter – 6 – Cascading Style Sheets 

A. Choose the correct answer 

1. (c) dynamic  2. (b) Cascading style sheets 3. (d) Dynamic 

 4. (a) Not supported by all modern browsers  5. (c) {property: value; property: value} 

6. (a) Inline  7. (d) Selector   8. (a) Property 

9. (b) Value  10. (c) class 

B. Short Answer type questions. 

1. Giving a real life example, explain how a dynamic page different from static. 

Static web page shows information which is fixed and does not need to change. For example, 

any article written on a topic on a particular date. Dynamic web page displays information 

that changes or it responds in different ways when user interacts with it. For example, when 

user enters a wrong password, the web page displays error message or a web page displays 

the count of currently logged on users. 

 2. What is the role of CSS in DHTML? 

A web site contains several hundred web pages. Any change that needs to be reflected on all 

or most of the web pages needs a lot of effort and man-hours. Using CSS, various formatting 

styles (colour, design, font, size, background etc.) of the web site are defined separately and 

each web page refers to these styles. Making a change in any style would automatically 

reflect that change in all the web pages referring to those styles. That is what CSS does. 

CSS is a way to apply styles on HTML elements. 

 3. When is inline style sheet suitable to use? 
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Inline styles are defined within the opening tag of the desired element. This method is useful 

if very little changes need to be done to a particular element which is specific to that 

particular web page. 

4. What do we need to do to make browsers of older versions ignore CSS? 

 To make older browsers ignore CSS, use comment notations <!-- and --> around your CSS 

definition.  

When an old browser displays the web page, due to these comment notations, it ignores the 

CSS definition while any modern browser will skip comment notations and process the style 

rules. 

For example, 

<style> 

<!-- 

P {color:green; font-face:arial; font-size:10pt} 

--> 

</style> 

5. What are the properties of a web page which we can stylise using style sheets?   

 Font and text, borders, background, margins and padding. 

6. What is the basic difference between background-color and background-image? 

Background colour is applied by using property background-color and it is applied as a solid 

colour behind the content while background image is applied using property background-

image. It displays the given image in the background of the content. If both the properties are 

used then background-image is given the priority. 

 7. Write the syntax of LINK element. 

<LINK TYPE=“type of css file” REL=“stylesheet” HREF=“url of stylesheet”> 

Example: <LINK TYPE=“text/css” REL=“stylesheet” HREF=“mystyle.css”> 

 8. What do you mean by a selector and a class? 

A selector is the name of any element that is mentioned while specifying CSS rule in the 

stylesheet while class is applied to a group of elements that should share same style. 

 9. Write an example of universal selector. 

*{color: blue; font-family: arial; font-size:10pt; word-spacing:5; text-align:right} 

 10. List the precedence of 3 types of stylesheets giving an example. 

Style1.css 

P{color:red} 

H1{color:green} 

H4{color:gray} 

HTML Code: 

<html> 

<head> 

  <LINK TYPE=“text/css” REL=“stylesheet” HREF=“style1.css”>   

<style> 

  P{color:green} 
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  H1{color:red} 

 </style> 

<body> 

<H1>Welcome</H1> 

<P style="color:blue">This web site is dedicated to….</P> 

<H4> Contact us at….</H4> 

 </body> 

</html> 

Here, colour of the text on P element will be blue since priority of inline stylesheet is highest. 

The content in H1 will be displayed ib red colour because second priority is given to Internal 

style sheet. Contents of H4 will be displayed in gray colour. 

C. Long answer types questions. 

 1. Discuss the advantages and limitations of CSS. 

 Advantages of CSS 

1. Time and effort in designing the web pages is saved significantly since styles are defined 

once in style sheet. 

2. Web pages get a consistent look throughout the website. For example, if a web site is 

following a theme called “Ocean” then shades of gray, blue and green can be defined in 

various styles of paragraphs, headings and backgrounds etc. once in style sheet and it would 

be cascaded on all the pages. 

3. Since HTML coding is minimised, web pages load comparatively faster. 

4. Errors are minimised in updating the designes of the web pages. 

Limitations of CSS 

CSS has a few limitations like it is interpreted by different browsers differently hence a web 

page design may be rendered a little different in one browser than in the other. Another 

limitation is that CSS stylesheets are simple text files which can be easily modified by 

anyone who has access to them. This may pose a serious problem since CSS files contain 

hyperlink addresses and paths to different image files used in the web page designs. 

2. How will you apply your school’s image in the background of a web page? Image 

should not be  repeated and should not be scrollable. 

body { 

  background-image: url(“school-logo.jpg”); 

  background-repeat: none; 

  background-attachment: fixed   

 } 

 3. A web site has 100 pages. Each page contains several elements and all 100 pages 

should look consistently similar in design and layout. What solution do you suggest to 

do so and why? 

The best solution to provide consistently similar design and layout to all the web pages is to 

use external stylesheets. The reason is that external style sheets are separate files from the 

web page files and can be easily maintained. If any time, any change in design needs to be 

done to all the pages, only concerned stylesheet needs to be changed once and changes will 
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reflect immediately to all the web pages. This is better than changing each web page 

individually.  

 4. Explain the advantage of using class as selectors. 

 Using class as selector, we can apply a style to multiple elements. This is useful when certain 

parts of a webpage have similar kind of design and layout. We do not need to locate the 

elements by their name. Instead we can give them a class name using class attribute and use 

that class name as selector in the style defined for them in one place. Advantage is that, if we 

need to apply any other style to all those elements in future, we can change their classname 

only and make them refer to a different class of style definition. 

5. Consider the CSS and HTML code below and explain the output of the web page. 

Support your answer with suitable explanation: 

   The CSS File (mystyle.css) 

  H1{ 

   color:red; font-family:arial 

  } 

  The HTML page using mystyle.css 

  <HTML> 

  <HEAD> 

   <LINK TYPE=“text/css” REL=“stylesheet” HREF=“mystyle.css”> 

   <STYLE> 

   H1{ 

    color:green;  

    font-family:Verdana 

      } 

   </STYLE> 

  </HEAD> 

  <BODY> 

   <H1 style=“color:blue; font-family: Garamond”> 

Learning CSS 

</H1><br> 

   <H3>Introduction</H3> 

</BODY> </HTML> 

 6. Briefly explain any two CSS properties of font, text, border and background. 

<style> 

 H1{ 

  font-family:serif; 

  font-size:xx-large; 

  letter-spacing:3; 

  text-align:right; 

  border-width:5px;  

  border-style:double; 
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  background-image:url(“edusoftlogo.png”) 

  background-repeat:repeat-x 

} 

 7. What are span and div element used for. What is the basic difference between them? 

 HTML provides two elements which do not change the formatting and appearance of web 

page contents but they can be used to organise web page content into smaller blocks which 

are easy to organise and manage. These elements are span and div.  

Using span and div we can divide web content into separate blocks or pieces of text. 

span is groups content inline that means there is no line break between two adjacent span 

blocks while div displays the content block fro <HTML>  

<head> 

 <title> Window title </title> 

</head> 

<body> 

 <SPAN style=“background-color:yellow”> This is span block 1.  </SPAN> 

 <SPAN style=“background-color:lime”> This is span block 2. </SPAN> 

 <DIV style=“background-color:lightgreen”> This is div block 1. </DIV> 

 <DIV style=“background-color:lightblue”> This is div block 2. </DIV> 

</body> 

</HTML>m new line. 

8. How do external style sheets help us provide consistent look to the web site? 

Refer to question 3 - The best solution to provide consistently similar design and layout to all 

the web pages is to use external stylesheets. The reason is that external style sheets are 

separate files from the web page files and can be easily maintained. If any time, any change 

in design needs to be done to all the pages, only concerned stylesheet needs to be changed 

once and changes will reflect immediately to all the web pages. This is better than changing 

each web page individually.  
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UNIT 3 
 

Chapter – 7 – Cyber-ethics 

A. Choose the correct answer 

1. (a) Ethics  2. (b) Cyber-ethics  3. (d) Privacy   

4. (c) Privacy policy 5. (a) HTTP with Security 6. (d) All of these (they are Digital 

property)  7. (c) Plagiarism  8. (d) Open source 

9. (a) GNU is not Unix     10. (c) Free software 

B. Short answer type questions 

1. Explain the terms ethics, cyber-ethics and privacy. 

Ethics informs us about the right and wrong aspects of anything - our beliefs, religion, society, 

profession and our values. Cyber-ethics refers to the fundamental rules and values, which 

govern us to make the right and judicious use of cyber space. Limiting or preventing access to 

anyone's personal, financial and other transactional details by unauthorised agency is called 

privacy. 

2. What is the role of privacy in E-Commerce? 

Limiting or preventing access to anyone's personal, financial and other transactional details by 

unauthorised agency is prime focus of maintaining privacy. Another aspect is individual's right 

to be protected from undesired attention (like unwanted mails, notifications and phone calls). 

This is called right to anonymity. Exchange of information between buyer and seller occurs in 

different ways such as while registering for the service or on web site and while buying a 

product or service. It is the responsibility of the buyers that they provide required information 

correctly and businesses are responsible to keep these details secured to respect the privacy of 

the individual. Businesses should have suitable policies and security processes in place to 

ensure privacy practically. Buyuer's should also be allowed to exercise their choice whether 

they need their details to be shared wholly or partly with other parties. 

3. How privacy should be safeguarded? 

Websites should ensure putting up suitable industry standard measures to protect user data. 

Some of such standard measures are listed below: 

• Strong security measure through technology such as data encryption through Secured 

Socket Layer with HTTP (https), firewalls and antiviruses on the servers, regular 

updates in security measures, data backups and training of their staff as required etc. 

• Constant monitoring process to identify and counter any possible threats. 

• Educating and notifying users in safe transaction practices. 

• Industry standard compliance certifications for financial transactions. For example, 

SSL certifications, Payment Card  Industry Data Security Standard (PCI DSS) for 

electronic card-based transactions. 

4. What is a privacy policy? 

Privacy policy of a business mentions how the details provided by the buyers will be kept 

secured to respect the privacy of the individual. Policy should also mention terms and 

conditions of services provided, type of information to be collected from the customer, purpose 

of information collection and what security practices are being followed by the business to 

keep the information secured. 



  Computer Applications CBSE Code 165 

 

68 

 

5. What do you mean by online fraud? 

Online buying and selling has attracted agencies with mala fide intentions in different ways 

such as Phishing ( fraudulently acquiring sensitive information by impersonating trusted 

websites), Pharming (redirecting website data to another unauthorised server),  Scamming 

(sending mails and newsletters of schemes that are too good to be true but very tempting like 

get-rich-quick schemes, online lottery and betting, alluring games and apps, fake charity 

schemes, investment in non-existent companies.) 

In addition to above, there are other forms of fraud like short delivery or non-delivery of 

goods, deviation from return policy, improper delivery of services committed, delay in service 

delivery and addressing grievance etc. 

6. What is HTTPS, SSL and SFTP? 

The secured version of HTTP is HTTPS – HTTPS with Secure Sockets Layer (SSL). Using 

HTTPS, web sites transfer and display content over the internet securely. Secured Socket Layer 

(SSL) data transfer is a way to transfer the data among web sites and between a web server and 

user's browser in encrypted form. 

In the similar way, while uploading and downloading files we need to ensure that the website 

providing file transfer services is using secured shell file transfer protocol (SFTP). This is 

called SSH + FTP wherein secured shell network protocol encrypts the credentials during 

transfer. 

7. What so you mean by IPR? 

In this information age, information is created, transferred, used and changed in several ways. 

Information created through a thought process and creativity in any form is called intellectual 

property. The prime owner of the information is the creator of that information and owns the 

right to do whatever needs to be done with that. Without owner's consent, information cannot 

be used, reused or exploited in any way.  

The right to protection of the intellectual property is called intellectual property right. 

8. Explain the terms piracy and plagiarism. 

The unauthorized use of any intellectual property is called piracy. Piracy can be done in 

different ways such as reproducing someone's work as it is without suitable authorization like 

copying songs, stories, designs etc. Plagiarism generally refers to stealing literary or academic 

work or content from original creator and claiming to be its owner. 

9. What do you mean by digital property? 

Any intellectual property in digitized form is called digital property. For example, a written 

song recorded in a video or sung in an audio, social media accounts and pages, images, videos, 

audios, all kind of accounts that access digital media, online gaming accounts, registered 

domain names, mobile apps, software, online service account etc.  

The owner of the digital property is either the creator or the person who got it created by legal 

payment and process. Digital properties are protected by licenses for use, distribution, 

alteration and updates. 

10. What is an open source software? 

An open source software is different from propriety software in that it gives freedom with 

flexible conditions to use, reuse, modify and distribute the software for various purposes like 

educational, personal or commercial use without paying royalty to the original or previous 

creators. Open software is not free software. In open source software there is no charge on the 

source code of the software. 
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C. Long answer types questions. 

1. Explain the terms FLOSS, GNU, OSI, Shareware and  Freeware. 

FLOSS: Free/libre open source software (FLOSS) which is free as well as open source.  

GNU: It is a recursive acronym for Gnu's Not Unix. Initiated by Richard M. Stallman, this 

project began with the philosophy of free software and development of a free operating system 

like Linux. Today there are many application software under GNU such as Gimp, Inkscape etc. 

OSI: The Open Source Initiative (OSI) is a non-profit organization to promote of open-source 

software. OSI was founded in 1998 by Bruce Perens and Eric Raymond. OSI, as compared to 

FSF is more business driven. 

Shareware: Shareware is distributed free but license is retained by the owner of the software. It 

is distributed on a trial basis with the understanding that the user may need or want to pay for it 

later. Some software developers offer a shareware version of their program with a built-in 

expiration date (after 30 days, the user can no longer get access to the program). Other 

shareware (sometimes called liteware) is offered with certain capabilities disabled as an 

enticement to buy the complete version of the program. 

Freeware: Freeware is a software which is distributed for free use but not for modification to 

the users. Its source code is not distributed free. It is mostly for private or non-commercial 

purpose. Example: Internet explorer from Microsoft, free antiviruses, Chrome from Google. 

2. Explain how cyber-ethics addresses privacy safe guarding and online fraud issues. 

Limiting or preventing access to anyone's personal, financial and other transactional details by 

unauthorised agency is prime focus of maintaining privacy. Another aspect is individual's right 

to be protected from undesired attention. Exchange of information between buyer and seller 

occurs in different ways such as while registering for the service or on web site and while 

buying a product or service. Businesses are responsible to keep these details secured to respect 

the privacy of the individual. Businesses should have suitable policies and security processes in 

place to ensure privacy practically. Buyer's should also be allowed to exercise their choice 

whether they need their details to be shared wholly or partly with other parties.  

The privacy policy mentioning how customer's and visitor's data will be collected and used 

should be made available to them.  

Websites should ensure putting up suitable industry standard measures such as: 

• Data encryption through Secured Socket Layer with HTTP (https), firewalls and 

antiviruses on the servers, regular updates in security measures, data backups and 

training of their staff as required etc. 

• Constant monitoring of threats. 

• Educating and notifying users in safe transaction practices. 

• Industry standard compliance certifications for financial transactions like SSL, Payment 

Card Industry Data Security Standard. 

Fraud Prevention by Secured Transactions 

Online frauds include Phishing ( fraudulently acquiring sensitive information by impersonating 

trusted websites), Pharming (redirecting website data to another unauthorised server),  

Scamming (sending mails and newsletters of malicious schemes.) In addition to above, there 

are other forms of fraud like short delivery or non-delivery of goods, deviation from return 

policy, improper delivery of services committed, delay in service delivery and addressing 

grievance etc. Such frauds can be dealt with with effective laws of the region. 
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Common safety measures against frauds are listed below: 

HTTPS websites: The websites run on hypertext transfer protocol (HTTP). The secured version 

of HTTP is HTTPS – HTTPS with Secure Sockets Layer (SSL). Using HTTPS, web sites 

transfer and display content over the internet securely. HTTPS is now used for authentication 

purpose. HTTP is less secure as it transmits data as unencrypted plaintext, which is prone to 

misuse and malicious attacks by hackers and scamsters. To recognise a secured url, look for the 

icon of a closed padlock by the side of url in the address bar of the browser. 

Secured Socket Layer (SSL) data transfer is a way to transfer the data among web sites and 

between a web server and user's browser in encrypted form. 

In the similar way, while uploading and downloading files we need to ensure that the website 

providing file transfer services is using secured shell file transfer protocol (SFTP). This is 

called SSH + FTP wherein secured shell network protocol encrypts the credentials during 

transfer. 

3. How should businesses ensure customers’ privacy and information protection? 

Businesses should ensure putting up suitable industry standard measures to protect user data. 

Some of such standard measures are listed below: 

• Strong security measure through technology such as data encryption through Secured 

Socket Layer with HTTP (https), firewalls and antiviruses on the servers, regular 

updates in security measures, data backups and training of their staff as required etc. 

• Constant monitoring process to identify and counter any possible threats. 

• Educating and notifying users in safe transaction practices. 

• Industry standard compliance certifications for financial transactions. For example, SSL 

certifications, Payment Card Industry Data Security Standard (PCI DSS) for electronic 

card-based transactions. 

4. Write a note on internet technology that helps in secured data transfer. 

HTTPS websites: The websites run on hypertext transfer protocol (HTTP). The secured version 

of HTTP is HTTPS – HTTPS with Secure Sockets Layer (SSL). Using HTTPS, web sites 

transfer and display content over the internet securely. HTTPS is now used for authentication 

purpose. HTTP is less secure as it transmits data as unencrypted plaintext, which is prone to 

misuse and malicious attacks by hackers and scamsters. To recognise a secured url, look for the 

icon of a closed padlock by the side of url in the address bar of the browser. 

Secured Socket Layer (SSL) data transfer is a way to transfer the data among web sites and 

between a web server and user's browser in encrypted form. 

In the similar way, while uploading and downloading files we need to ensure that the website 

providing file transfer services is using secured shell file transfer protocol (SFTP). This is 

called SSH + FTP wherein secured shell network protocol encrypts the credentials during 

transfer. 

5. What is IPR? How piracy and plagiarism should be prevented or minimised? 

The right to protection of the intellectual property is called intellectual property right.  

Preventing piracy and plagiarism has been a big challenge due to the widespread use of 

creative work. It is almost difficult to monitor piracy and plagiarism. Only when the offence 

has been committed and caught somehow, the action is taken. Still, we can follow some 

measures as listed here to prevent piracy upto some extent: 

• We, as learned and rational individuals should take this up as our moral duty and also 

help spread awareness about using genuine product.  
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• We should ensure not to purchase pirated content, insist on buying original software 

and avoid distributing unintentionally among friends and relatives.  

• Governments should take initiatives like stringent laws and their enforcement to protect 

intellectual property of all kinds and spread awareness though social messages about its 

ill effects and consequences.  

• A community drive and urging large student community to promote anti-piracy 

measures.  

• Promoting reward campaigns for those who report piracy. 

• Software audits in companies. 

6. Describe the terms that should be satisfied in order for a software to be called open 

source. 

Open source software should satisfy following distribution terms as per the open source 

definition version 1.9 on opensource.org. 

• Free redistribution: The license shall not require a royalty or other fee in redistribution 

of software. 

• Source code: Source code must be distributed along with the compiled code. 

• Derived works: Modifications in code are allowed along with derived works and 

software must be distributed under the original license terms. 

• Integrity of the Author's source code: Every alteration should bear the different name or 

version number form the original software. 

• No discrimination against persons or groups: Program or software can be used by 

anyone irrespective of any field of endeavour. 

• Distribution of license: Rights attached to the program must apply to all to whom it is 

redistributed. 

• License must not restrict other software: License must not place any restrictions to 

other software that is distributed along with. 

• License must be technology neutral: No provision of the license may be predicated on 

any individual technology or style of interface.    

7. Briefly describe various open source licences. 

Open source licenses help collaborative developers and contributors to come together easily 

without worrying about permissions and rights. It ensures that others do not plagiarise or pirate 

your work. Some common openlicences are: 

• GNU General Purpose Licence: It is the most common of all the open source licences. 

It allows copy, modify and distribute the software legally. A GPL has following 

provisions: 

• No limit to copies of software. 

• Freedom from the method of distribution. Users or developers can distribute software 

by any  means or mode they like. 

• Modified software can be charged but software remains under GNU GPL. 

• Freedom of complete modification of the source code but new release should be under 

GNU GPL. 

• GNU Lesser General Purpose Licence: This is also known as library GPL because the 

restriction of having to release software extensions in Open GPL are not there in LGPL.  

• Berkeley Software Distribution License: They are mostly used for the distribution of 

many freeware and shareware as well as open source software. BSD license is in fact a 

family of permissive free software licenses with fewer restrictions on distribution. The 

3 clause BSD license allows unlimited redistribution as long as it copyright notices and 
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warranty disclaimers are retained. Also, names of contributors cannot be used to endorse the 

derived work without their permission. Simplified or Free BSD license is like 3 clause BSD 

without having restriction of usage of names of contributors for endorsement. 

• Massachusetts Institute Technology License: It is just like BSD license with a difference that 

BSD-style licenses sometimes contain a clause prohibiting the use of copyright holder’s name 

in promotions without permission while MIT license does not contain such clause. As per MIT 

license,  material redistributed should have the original license. 

• Apache License: The Apache License is a FOSS licensing agreement from the Apache 

Software Foundation. This license allows perpetual i.e. forever active, worldwide, absolutely 

free, non-exclusive or non-proprietary and irrevocable rights. It has following provisions: 

o Software may be freely used, reproduced, modified, distributed or sold. 

o Software can be combined with other products and distributed or sold as packages. 

o Products derived or modified from licensed software can be distributed under other 

licenses. 

o Apache software cannot be redistributed without attribution. 

o A copy of the license must be redistributed along with any Apache software. 

o External contributions to the software are released under the ASF terms unless 

explicitly specified otherwise. 

8. Write a note on digital India. 

Access to information in public domain refers to the right to information. Internet, despite its 

wider reach, is still needs means of its access in many remote areas of the country. The 

inequality at economical and social level in accessing and using information and 

communication technologies. 

Many rural and remote areas still need to have suitable means to access information over 

internet and telecom network. With a little more than 500 million users still a lot needs to be 

done. Access to internet in urban areas is more than 50% than that in rural areas. The lack of 

infrastructure, availability of bandwidth and digital literacy are being addressed by the 

government at a rapid pace now.   To ensure that government services and government 

schemes' information reaches to masses online easily, government of India (GoI) launched 

Digital India campaign in July 2015. Connecting rural areas over high speed internet 

connection to bring the remote areas of the country into mainstream and improve digital 

literacy is the ambitious objective of the campaign. Under this campaign the National 

eGovernance Plan is aimed at brining various digitised service to the masses. Some of the 

common services are digilocker, e-education, e-health, e-Education, e-Sign and e-Shopping. 

Other platforms which are the part of this campaign are as follows: 

• Access to mygov.in portal that lists details of all the government services and schemes. 

• Multi channel, multi-lingual, multi-service mobile app Unified Mobile Application for 

New Age Governance (UMANG) to access all government services over handheld 

devices. 

• Adhaar number has enable to access digital signature service eSign. 

• People can keep digital copies of their important documents over DigiLocker. 

• eHostpital application to enquire about various services like blood donation, 

appointments, payments etc. 

• Swachh Bharat Mission app tp promote cleanliness as a nationwide mission. 

• eSampark application to promote communication in regional language. 

• Pradhanmantri Digital Saksharta Abhiyan to make rural households digitally literate. 
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UNIT 4 
 

Chapter – 8 – Scratch Programming - II 

A. Choose the correct answer. 

1. (a) Event 2. (c) Both are loops   3. (d) Looks  4. (d) 0,0 

5. (b) pen down 6. (b) say for n secs  7. (c) answer 8. (a) if 

9. (b) Sprite 10. (d) Tempo 

B. Short answer type questions.  

1. What is Scratch? List main parts of Scratch interface. 

Scratch is a free visual programming language developed by Media Lab of Massachusetts 

Institute of Technology, Cambridge, Massachusetts. The purpose of developing Scratch 

was to provide a fun oriented, easy and block-based visual tool for kids to learn computer 

programming approach. 

Using Scratch, children can create interactive stories, fun oriented 2D animations and 

interactive games. Scratch creations can be shared online also with others. 

2. List any 5 Event and Motion blocks. 

Event blocks: When the sprite clicked, when I receive, broadcast, when animation flag 

clicked, when key pressed 

Motion blocks: move n steps, turn n degrees, point in direction, go to x y, set x to  

3. Briefly describe Motion block point in direction __ . 

Point in direction block is used to change the direction of the sprite for next movement. 

With this block we need to specify the direction as 90 – for right, -90 for left, 0 – for up 

and 180- for down. 

4. What is the basic difference between say ____ and say ___ for __ secs blocks.  

Say block displays the given text forever while say for secs block will display the given 

text for the duration in specified seconds.  

5.What is the difference between Motion blocks Move and Glide? 

Move block moves the sprite by the given number of steps at constant fixed speed while 

glide block moves the sprite in given duration in seconds to specified x, y coordinates. 

6. Write the steps to bring the sprite to the center of the stage on the click of 

spacebar and make the pen ready to draw. 

When space key pressed    When space key pressed 

Set x to 0   OR   glide 1 secs to x: 0 y: 0 

Set y to 0      pen down 

Pen down 

7. List the steps to create a variable by the name AGE. 

Go to Data category on Scripts tab. Click on “Make a Variable” button. In the dialog box, 

type the name of the variable as AGE and click on OK.  
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8. How will you generate a random number in Scratch? 

Random number can generated between any two numbers by using “Operators” block 

pick random n1 to n2  where n1 is lower number and n2 is higher number between which 

any number will be generated. For example, pick random 10 to 20 may generate any 

random number between 10 and 20.  

9. Write the steps to stop all the sounds that are playing when the sprite is clicked. 

When this sprite clicked 

  Stop all sounds 

C. Long answer types questions. 

1. What is the basic difference between repeat and forever blocks? Explain with 

suitable examples. 

repeat block executes the enclosed blocks as many times as the number mentioned in its 

value section while repeat until block takes a condition and executes enclosed blocks as 

long as that condition becomes true. 

Example:   repeat 5 

     Move 10 steps 

forever block executes the enclosed blocks infinitely. While using such block, it is 

necessary to make provisions to break the loop and come out of it using if block 

Example:   forever 

     Move 10 steps 

     If touching red colour 

       Stop all  

2. What is the role of Event blocks in animation? Describe any 5 main Event blocks 

& their use. 

Event blocks help in controlling the animation and make the animation interactive in such 

a way that animation responds to the user actions. For example, when sprite is clicked 

some action occurs. 

1. When animation flag clicked: Animation begins when this button on the top of the 

stage (with green flag icon) is clicked. 

2. When this sprite clicked: The script runs when user clicks on the sprite with mouse. 

3. When ____ key pressed: The script runs when user presses the specified key like 

spacebar. 

4. When I receive _____: The script runs when the sprite receives the given text 

broadcasted by another sprite. 

5. Broadcast: It helps send the specified message to other sprites. 

3. What are the different ways to add sound in your animation? How will you record 

and add a sound in animation? 

1. Adding Sound from Sound Library: Sound library of Scratch contains a collection of 

several sounds which can be added in the animations. 

To open the sound library, click on Choose sound from library button in Sound tab. In the 

library, select the desired sound and click OK. The sound will be added. 
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2. Recording Sound and Using External Sounds 

Sound can be recorded in Scratch using the microphone or you can also insert sound 

files from your computer or any external source. 

To record the sound, click on Record New Sound button in Sound tab. 

In the sound recording interface, type the desired name of the sound (.e.g mysound1). 

To begin recording, click on Record button. Recording will start. 

To stop recording, click on Stop button. 

To test play your recording, click on Play button. 

4. Giving at least 3 examples, describe the use of Operator blocks.  

Operator blocks are used to process the data in various ways and to compare the values.  

1. We can generate random numbers between two given numbers by using Operators 

block pick random __ to __. Smaller number is mentioned before to and larger after 

it. 

2. __ + __: Returns addition of two numbers mentioned on either side of + sign. 

3. __ - __: Returns subtraction of two numbers mentioned on either side of - sign. 

4. __ * __: Returns product of two numbers mentioned on either side of * sign. 

5. __ / __: Returns division of two numbers mentioned on either side of / sign. 

5. Describe the situations where you should use if block and if-else block with 

example. 

if block is associated with a condition. All the blocks that 

are part of if block are executed only if the condition is 

true. Let us understand this with following script. if block 

makes use of comparison blocks in Operators category.  

In this script, a variable passcode is used. First, user is 

asked to enter a passcode. Value entered by the user will go into Sensing block answer. 

Notice, how if block condition is created by the help of Operators block equal-to. Before 

= sign, answer block is kept and after = sign, the passcode harry123 is kept. Both the 

values will be compared for equality (similar). If values of answer block is harry123 then 

message WELCOME will be displayed. 

 

There are situations where you may need to perform some 

other action when if condition fails or returns false. This is 

handled by else part of if-else block. 

The blocks inside the else block execute only if the 

condition associated with the if block is not satisfied (false). 

Consider the script shown here. 

Whenever the Cat is not touching the bananas, the condition: touching Bananas will 

return false and in such case else part will execute, making the Cat say: Where are the 

Apples?. 
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6. If forever block runs infinitely then how can it be stopped. Explain with an 

example. 

Forever block can be terminated or stopped by making check with if block and using stop 

block within if. For example: 

   Forever 

    Move 100 steps 

    Turn 90 degrees 

    If touching color red 

      Stop all 

7. What is an event?  How do sprites respond to each others' messages? Explain 

with an example. 

An event is any action performed by user or program. For example, user clicking with 

mouse on the sprite, pressing a key on the keyboard, an sprite broadcasting message to 

other sprites etc. Scratch provides a set of event blocks to handle such events. They are 

found in Events category in Scripts tab. 

For example: 

Sprite 1:     Sprite 2 

When this sprite clicked    when I receive “ouch” 

  Broadcast “ouch”    say “hey, what happened?” 

8. How repeat block is different from repeat until block? Give example. 

repeat block executes the enclosed blocks as many times as the number mentioned in its 

value section while repeat until block takes a condition and executes enclosed blocks as 

long as that condition becomes true. 

For example, in the given script, Click on the sprite. It will 

first go to coordinates 0,0 then it will glide up to coordinates 0, 

25 taking 1 second and glide back down to coordinates 0,-25. 

This will be repeated 5 times. Why? The repeat block will 

execute both the glide blocks 5 times as you have specified. 

 

repeat until block is useful when you need to execute certain blocks repeatedly for a given 

count. repeat until block can be used when you need to control the animation on the basis 

of a condition such as until sprite touches another sprite, until player’s life in a game 

becomes 0, until user clicks a particular key. 

For example, here, a variable counter is taken which is set to 

0. This counter will be increased by 1 every time sprite Cat 

finishes one jump (up and down using glide blocks). When 

the value of counter becomes 5 (i.e. 5 jumps are done) the 

condition counter=5 will be true and repeat until loop will be 

over. 

Notice, how the value of counter is increased by stating: 

counter = counter + 1 using Operators block __ + __.   
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Chapter – 9 – Python Revision 

A. Choose the correct answer. 

1. c) interpreted 

2. c) Interactive, script 

3. a) Python shell 

4. b) # 

5. d) No output 

6. a) dynamically typed 

7. a) string 

8. b) floats 

9. c) strings 

10. b) + 

B. Short answer type questions. 

1. List any 5 features of Python. 

It is an easy to learn, write and read hence most suitable for programming begiinners. 

Programs written in Python can run on all modern platforms like Windows, Linux and Mac. 

2. What is the basic difference between Interactive mode and Script mode? 

In interactive mode user keys in one command at a time and in response to theat command Python 

displays the output. The commands are issued at Python command prompt denoted by >>>. For 

example, If you type: (1 + 7) * 2 

Then, immediately the result 16 will be displayed. Then you issue next command, get its output and 

so on. Interactive mode does not save your commands for later use. 

In script mode, the python commands are saved in a logical order to get the desired output. This 

logical set of instructions is called script. Once the script is saved, it can be executed anytime. 

3. How will you accept the name of the user using raw_input()? Write complete script. 

n = raw_input(“Enter your name: “) 

4. How floats are different from integers? 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. Floats store values up to 15 decimal places. 

5. What do you mean by operand and operator? Give example. 
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Arithmetic operations involve two parts – operands and operators. Operands are the values on which 

arithmetic operation is performed and operators are the symbols that denote a particular operation. For 

example,  a = 5 + 2  Here, 5 and 2 are operands and + sign is addition operator. 

6. Explain the dual role of + operator. 

+ operator functions as addition operator with numeric values and as concatenation operator with 

strings.  

7. How will you convert integer into string and vice versa? 

str() converts numeric value into string. For example, 

price = 366.54 

str_price = str(price)  str_price will have string 366.54 

 

int() converts given string into number. 

age = “65” 

iage = int(age)  iage will have number 65 

8. What is the use of ** and * operators? 

** is exponent operator. For example, 

a = 2**3 will return 8 (2 exponent 3) in variable a. 

* operator is multiplication operator. For example,  

a = 2 * 3 will return 6 in variable a. 

9. What is complex data type? 

The fields of engineering, advanced science and advanced mathematics deal with complex numbers. 

They are used in the scientific description of the phenomena and world around us. Complex numbers 

have no relevance at this level here so we shall leave complex numbers out. 

10. Why floats are called real numbers and not integers. Give example. 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. For example, 

a = int(14.55) will return 14 only and a will be of number type because integer discards decimal 

places. 
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C. Long answer type questions. 

1. Describe various data types in Python. 

Text or strings 

In computer programming terminology, text is called string. Strings are always enclosed in double 

quotes. When computer or Python interpreter encounters any value that is in double quotes, it treats it 

as string. For example: "I am a Python fan", "My country India", "123", "920431143" etc. Did you 

notice last two values? "123" is not One hundred twenty three. It is a string to be read as: one two 

three. For computer it is not a number because of double quotes. Hence, "123" and 123 are different.  

Numbers or Integers 

Numbers are not enclosed in any quotes. So, 123 is one hundred twenty three. 17 is seventeen. 

There are certain variants of number type like int, long and complex. 

Int: These are plain positive or negative whole numbers like your age, your height, distance between 

your house and your school etc. 

For example: 

age = 12 

height = 10 

marks = 83 

Integers occupy 4 bytes in the memory to represent the value. So, all the variables above are of 4 

bytes size.  

Long: Numbers with huge values like distance between the earth and the sun, long scientific numbers 

are treated as long. Long integers occupy as much space in memory as the system on which the script 

runs allows. To denote that a number should be treated as long, the values should be suffixed with 

letter L. 

For example: distance_from_sun = 149L 

Here, the variable distance_from_sun will be allocated more than 4 bytes by the system. 

Complex: The fields of engineering, advanced science and advanced mathematics deal with complex 

numbers. They are used in the scientific description of the phenomena and world around us. Complex 

numbers have no relevance at this level here so we shall leave complex numbers out. 

Boolean: A Boolean value is either true or false. Booleans are treated as integers by the computer. 

False is denoted by 0 and True as 1. 

Floats 

Numbers with decimal places are called floats or floating point numbers. They are also called real 

numbers since they can store the precise numeric values. Floats store values up to 15 decimal places 

which is quite sufficient for majority of fields of computer programming.  
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The distance between the sun and earth is 149.6 million kilometers but in previous example of 

integers, we could only store 149 which is approx. value. A floating point type variable can store 

precise value: 

distance_from_sun = 149.6 

Numbers with scientific notations like exponents indicating power of 10 are also represented by 

floating point numbers: 

x = 7.8e3 

This translates to 7.5 X 103 

2. List the features of Python language. 

Python was developed by Guido van Rossum, and it is free software in the early 1990s. Python is an 

interpreted language with dynamically typed variables which means variables in Python do not have a 

defined type like in C++ or Java. Python has a rich set of built-in collection types like Lists, Tuples, 

Dictionaries and Sets etc. An interpreted language is translated and executed statement by statement 

until the end of the program or until any error is encountered. It is not like a compiler based language 

where program gets compiled into executable code by removing any errors first and then the compiled 

code is executed.  

Features of Python 

Python is open source programming language. You do not need to buy any license to use it. 

Download it and start using it just for free.  

It has features of both Object Oriented Programming languages like Java and C++ as well as 

procedural languages like C. 

It is an easy to learn, write and read hence most suitable for programming begiinners. 

Programs written in Python can run on all modern platforms like Windows, Linux and Mac. 

Python has a large, rich set of libraries to develop complex applications quickly and easily. 

Programs written in Python can be integrated with C++ and Java with least modifications. 

3. How will you create and run a Python script using IDLE and Script editor? 

Start IDLE 

Go to File menu and click on New File. This will open the editor. 

In the editor, type your program as below: 

Print( "Welcome to Python.") 

In the editor, go to File menu and click on Save. Type in myscript1.py and save the file in desired 

location. 

To run your program, in the editor, go to Run menu and click Run Module or alternatively you can 

press F5. This will run your file and the output will be displayed in shell. 
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4. What is a variable? How will you accept a value from the user into a variable? 

A computer program written in any language takes some input, processes it and generates the output. 

These values are stored in variables which are identified by unique names in the program. A variable 

stores one value at time. When a new value is stored in a variable the earlier value gets overwritten. 

As a program runs, the values in a variable might change hence the term variable – anything that may 

store different values but one at a time. 

Example 1: Calculate 25% discount on the given price. 

price = raw_input("Enter the price of the item: ") 

price = float(price) 

discount = price * 0.25 

price_after_discount = price - discount 

print("The price of the item is " + str(price)) 

print("Price after " + str(discount) + " discount is " + str(price_after_discount)) 

Here, raw_input() asks the user to enter a price value. User enters 565.99. This is assigned to variable 

price. float()converts string type returned by raw_input() into float. Using multiplication operator * 

25% discount is calculated and assigned to variable discount. Then price after discount is calculated 

using – operator. Finally, the output is displayed wherein non-string values are converted into strings 

using str() and + operator is used for concatenation. 

5. What is the basic difference between raw_input() and input()? 

raw_input() returns the input from the user in the form of string. input() returns the input from the user 

too but before returning it converts the value into suitable data type. So, if user enters a non-numeric 

value, it will be returned as string but if any number is entered, input() will return it as integer. 

Similarly, any fractional value like 2.75 will be returned by input() as float. input() takes an optional 

parameter of string type which can be used to display a prompt for the user. 

For example: 

a = input("Enter a number:"); 

print(a * a) will display 25 if user enters 5. No data conversion is required, input() has returned the 

value as number. 

a = raw_input("Enter a number:"); 

print(int(a) * int(a)) will display 25 if user enters 5. Data conversion is required using int() since 

raw_input() has returned the value as string. 
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6. Describe various arithmetic operators with one example each. 

 

7. Giving an example explain the implicit data type conversion in Python. 

During an arithmetic operation, if required, Python automatically does certain data conversion known 

as implicit data type conversion. 

For example:  

a = 2 * 3.5 This will result into a float value automatically taken care of by Python. 

8. What is the use of str() and int()? 

str() converts numeric value into string. For example, 

price = 366.54 

str_price = str(price)  str_price will have string 366.54 

 

int() converts given string into numeric value. 

age = “65” 

iage = int(age)  iage will have number 65 

9. What is concatenation? 

+ operator, besides being an addition operator on numeric values also serves as combining strings. 

For example, 

price = 345.99 

str_price = str(price) 

print("The price of the item is " + str_price) 
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Here, str()is used to convert the float value 345.99 into string and then + operator is used to 

concatenate the two string. 

10. What is the role of comments in a script? 

Python Comments 

Comments are a way to document the script or put explanatory remarks to your script. Any line in 

Python code that begins with # sign is treated as a comment by the Python interpreter and it is not 

executed. 

For example: 

#Following script displays greeting to the user 

print("Welcome to the world of programming!") 

#print("This is not going to execute") 

Here, first line is a comment and informs what the script is doing to anyone who refers to it but notice 

the last line. Since it is also prefixed with # sign it will not be executed. 

 

Chapter – 10 – Python Level - II 

A. Choose the correct answer. 

1. (c) Both a) and b)  2. (b) It is immutable  3. (a) key:value 

4. (b) mapping   5. (d) step   6. (c) membership 

7. (b) with if   8. (a) while   9. (b) binary    

10. Correction: for loop works through a list of values.  

B. Short answer type questions.  

1. Explain how list and tuple different from and similar with each other.  

Lists and tuples both are sequence of comma separated values.  

Lists are mutable, their values are changeable. Tuples are immutable, their values are not 

changeable. 

2. What is the role of key in a dictionary? 

Keys are used to access values. For example,  

print products['Item']  this will display Heater. 

3. What do the escape sequences \n, \t, \a and \\ mean? 

\\  Backslash itself (\) 

\n  New line or line break character 

\t  Tab 

\a  Bell sound 
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4. List one example of each type of literal. 

String literals: Values enclosed within single or double quotes are string literals. E.g. “Hello”, 

‘Hello’, “I001”,  ‘I001', “2241254” 

Multiline literals can be typed as “Hello \ 

            world”.   Here, \ is an escape sequence.  

5. What is the use of triple quotes in Python? 

Mulitple strings can also be created by enclosing strings into triple quotes like: 

'''This is a multi 

line string 

literal''' 

6. What do you mean by condition or comparison expression? 

A condition is an expression composed of operands and relational operators. They either 

return true or false depending on the values the compare. For example, (5<10) will return true 

while (5>10) will return false. Conditions are used in decision making using if or in 

controlling loops. 

7. How will you count a list of numbers in reverse using for loop? 

n=0 

for n in range(5, 1, -1) 

 print n 

This will print values from 5 to 1 

8. What will the statement: range(6) will return? 

0, 1, 2, 3, 4, 5 

C. Long answer types questions. 

1. Giving one example each explain collections. 

Collections are the data types that represent a set of more than one value. These are of 

following 3 types: 

Lists: Comma separated values enclosed between square brackets [ and ] are called lists. 

Individual elements of lists can be modified. This characteristic of lists is called mutability. 

Lists are mutable. 

l = []       This is an empty list 

a = [1, 1, 2, 3, 5, 8, 13]    This is a list of integers 

Tuples: Comma separated values enclosed between parentheses ( and ) are called tuples. 

Individual elements of tuples can not be modified. Tuples are immutable. 

t = ()   This is an empty tuple 

a = (1, 1, 2, 3, 5, 8, 13) 

Dictionary: Comma separated pairs of key and value enclosed between curly brackets { and } 

are called dictionary. Dictionary is also called Mapping in Python. Each key-value pair in a 

dictionary are separated by colon (:). A sample dictionary is shown below:  
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d = {}  This is an empty dictionary 

products = {'Item': 'Heater', 'Price':1200,  'Company':'Godridge'} 

Keys are used to access values. For example,  

print products['Item']  this will display Heater. 

2. How is data organised in a dictionary? There are names and ages of 5 students. Write 

the statement to create a dictionary of names and their ages. 

In dictionary, pairs of key and value are enclosed between curly brackets { and } separated by 

comma. 

students = {'Ravi': 16, 'Anu':14,  'Raj':20; 'Reena':16; 'Raj':20} 

3. Explain the working of range() function giving suitable example. 

range() function generates a list of numbers within a range of two numbers passed to it as 

parameters. For example, 

range(1,10) will produce:  

1, 2, ,3 ,4 ,5 ,6 ,7 ,8, 9   i.e. 1 to 10 - 1 

range(13, 17) will produce: 

13, 14, 15, 16    i.e. 13 to 17 -1  

So, the range() takes a lower limit of number and an upper limit. 

By default, the values of list created by range() include numbers incremented by one from the 

lower limit to the upper limit. You can change the value by which the numbers increase.  

This is done by the third parameter that range() takes. This parameter is called step 

parameter. A negative value for step parameter enforces the reverse counting of values. 

Examples, 

range(3)  will take 0 value by default and generate 0, 1, 2 

range(1, 10, 2) will generate 1, 3, 5, 7, 9 

range(25, 39, 3) will generate 25, 28, 31, 34, 37 

range(5, 1, -1) will enforce reverse counting and generate 5, 4, 3, 2 

range(3, 1) will generate empty list as progression of numbers is reversed 

4. Write the range() function to produce following lists: 

 a. 1, 2, 3, 4, 5    

 b. 1, 3, 5, 7, 9 

 c. 12, 11, 10, 9, 8 

 d. an empty list 

a. range(1, 5) 

b. range(1, 9, 2) 

c. range(12, 8, -1) 

d. range() 
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5. Explain the working of while loop with example. 

While is a conditional loop construct which executes the statements within itself as long as 

the conditions associated with it are true. When the conditions become false, the loop 

terminates. For example, 

n = 0 

while n < 5:  

 print(n, “\n”) 

 n = n + 1 

print(“Done”) 

The above code will print numbers from 0 to 4, one in each line. 

6. Explain the working of for loop with example. 

for loop is useful for processing values in a collection like list or string etc. in for loop, the 

control of reiteration occurs automatically unlike while where we needed to update the value 

of the variable that was being used in the condition of the loop. 

n = 0 

for n in range(0, 5): 

 print(n,“\n”) 

print(“Done”) 

7. What should be done if need arises to terminate the loop even before its condition or 

count is not expired? Explain with a suitable example. 

Loops can be terminated explicitly without having them wait for the condition to return false. 

This is achieved by using break keyword. Use of break terminated the loop. Any statements 

after break do not execute. For example, 

n = 0 

while 1: 

    n = input(“Enter number: ”) 

     if(n==0): 

        break 

     print(n * n, “\n”) 

Here, while 1 denotes while true. This loop has no condition associated so it will execute 

infinitely and accept a number from the user. Then it checks if the number entered by the user 

is 0. If so, the break keyword will terminate the loop, otherwise square of the number will be 

displayed in new line. 

8. How will you implement a for loop to display a sequence of numbers in reverse? 

for n in range(10,1, -1): 

 print(n,“\n”) 

 

 


